Parte I. Come Iniziare




Capitolo 1. In generale



Introduzione



GnuCash è un pacchetto software di gestione delle finanze personali. È sufficientemente versatile per tenere traccia di tutte le transazioni finanziarie, dalle più semplici a quelle più complesse; è uno dei pochi software finanziari che supporta tutte le valute del mondo ed è l’unico a codice aperto. Se questo non bastasse, è anche molto semplice imparare a usarlo.
GnuCash permette di tenere traccia delle transazioni finanziare con il livello di dettaglio che si preferisce. Se si è all’inizio, è possibile utilizzare GnuCash per tenere traccia dei propri assegni. In seguito si potrà decidere di considerare anche le spese sostenute con la carta di credito per meglio conoscere dove il denaro viene speso. Quando si inizierà a investire, sarà possibile utilizzare GnuCash per monitorare le proprie azioni. Si sta per comprare un’auto o una casa? GnuCash aiuterà a pianificare l’investimento e a registrare le rate dell’eventuale mutuo. Se le transazioni finanziarie che si eseguono sono a livello globale, GnuCash offre tutto ciò che serve per gestire le valute di ogni parte del mondo.
[image: GnuCash struttura dei conti - anteprima]Questa immagine mostra le finestre dei conti e dei resoconti di GnuCash con valute multiple e investimenti.



Anche se GnuCash si presta alla gestione delle finanze personali, è anche sufficientemente potente per un utilizzo professionale. GnuCash presenta infatti diverse caratteristiche dedicate all’impresa: dall’integrazione del sistema dei conti per debiti e crediti correnti, alla costruzione di tabelle per le tasse. Queste e molte altre funzioni dedicate all’attività professionale risulteranno sorprendentemente potenti e facili da usare.


Getting More Help



Online Help



The online help is the counterpart to this guide. It
      provides the detailed instructions for using
      GnuCash's menus, windows, and
      controls. To open online help, select Help → Contents.

GnuCash Wiki



An immense amount of less-formal documenation, both of
     GnuCash itself and its maintenance and
     development may be found in the GnuCash
     Wiki; the Frequently Asked
     Questions page should be a first stop whenever you
     encounter difficulty using
     GnuCash.

GnuCash On-line Assistance



Mailing List
The primary source of user support is the user mailing list. If
    you prefer a web forum-like presentation, you can use it via Nabble. One must subscribe
    before posting, even if using Nabble.
IRC
Several of the developers
    monitor the #gnucash channel at irc.gnome.org. They're usually
    doing something else, too, and of course aren't always at their
    computers. Log in, ask your question, and stay logged in; it may
    be several hours before your question is noticed and responded
    to. To see if you missed anything check the IRC logs.
The GnuCash web site 
        has more details on these channels. You will also find pointers there
        to additional useful resources such as the GnuCash wiki
        and bug tracking system.


Concetti sull’immissione dei dati



Quando si inseriscono dei dati in GnuCash, occorre avere ben presente i 3 livelli in cui GnuCash li organizza: file, conti e transazioni. Questi livelli sono in ordine di complessità; un file contiene diversi conti e un conto contiene più transazioni. Questa suddivisione è di fondamentale importanza per capire come utilizzare 
File



GnuCash immagazzina le informazioni al livello più alto nei file. Un file può essere conservato sul proprio computer o come un singolo file XML (in tutte le versioni di GnuCash) o in un database SQL (in GnuCash versione 2.4 o superiore).
Nota
SQL si pronuncia «sequel», quindi nel linguaggio parlato e scritto si dice «un database SQL».

Con il formato XML, GnuCash immagazzina i propri dati finanziari in un file di estensione .xml, generalmnete in formato compresso (aqnche se questa impostazione può essere cambiata nella scheda Generali delle Preferenze di GnuCash).
Con l’immagazzinamento SQL, GnuCash conserva i propri dati finanziari in un database SQL nell’applicazione per i database selezionata (SQLite3, MySQL o PostgreSQL).
È necessario avere un file o database principale per ogni gruppo di conti che si vuole mantenere. Per sapere come creare e gestire i file di GnuCash, consultare la sezione chiamata «Conservare i propri dati finanziari».
Nota
Se fosse necessario più di un gruppo di conti, si consiglia di rivolgersi a un contabile professionista prima di procedere. La maggior parte degli utenti avranno bisogno di un singolo file dei dati.

GnuCash genera automaticamente dei file di backup e di log quando necessario. Questi tipi di file sono discussi in la sezione chiamata «Creare copie di sicurezza e recuperare i dati».

Conti



Un conto tiene traccia di ciò che si ha, di ciò che si deve, di quello che si spende o riceve. Ogni file di GnuCash contiene un numero qualsiasi di conti, e ognuno può contenere diversi sottoconti per un numero qualsiasi di livelli. Questa semplice funzionalità fornisce a GnuCash la maggior parte della sua abilità nella gestione delle finanze, come verrà mostrato nei capitoli successivi.
Esempi di conti sono: il conto corrente, il conto dei risparmi, il conto della carta di credito, i mutui e i prestiti. Ogni conto di GnuCash tiene traccia dell’attività relativa al conto «reale» e fornisce informazioni sul suo stato.
Inoltre i conti sono utili per categorizzare il denaro ricevuto o speso. Per esempio, è possibile creare dei conti delle uscite per tracciare il denaro che si spende per i servizi o per i generi alimentari. Anche se per questi conti non si riceve un estratto conto, permettono comunque di determinare quanto denaro vieno speso in ogni area.
I conti verranno discussi in dettaglio in Capitolo 3, Conti.

Transazioni



Una transazione consiste nel movimento di denaro tra conti. Spendere, ricevere o trasferire denaro tra conti, rappresentano tutte delle transazioni.
Esempi di transazioni sono: pagare la bolletta del telefono, trasferire denaro dal conto bancario al proprio portafoglio, prelevare denaro, depositare un assegno. L’inserimento delle transazioni è discusso in Capitolo 4, Transazioni
In double entry accounting,
      transactions always involve at least two accounts–a source
      account and a destination account.
      GnuCash manages this by inserting a line
      into the transaction for every account that is affected, and
      recording the amounts involved in each line. A line within a
      transaction that records the account and amount of money involved is
      called a split. A transaction can contain an
      arbitrary number of splits.
Nota
Le suddivisioni per le transazioni verranno descritte in la sezione chiamata «Split Transaction Example»



In pratica



Nota
In questa sezione si inizia un esempio che procederà attraverso tutto questo documento. Alla fine di ogni capitolo, è presente una sezione denominata in pratica che riporta degli esempi che illustrano i concetti discussi in questa sezione. Ogni sezione in pratica è basata sulla precedente, per questo è importante assicurarsi di aver salvato il file per potervi accedere facilmente e continuare il lavoro.

Si parte!
	Prima di tutto si deve creare un file per conservare i propri dati finanziari. Aprire GnuCash e selzionare File → Nuove file dalla barra del menu. Verrà avviato l’assistente per l’Impostazione di una nuova struttura dei conti che permette di creare più conti in una sola volta.
Nota
Se si sta eseguendo GnuCash per la prima volta, verrà visualizzata la finestra denominata Impossibile trovare i valori predefiniti descritta nel dettaglio nel manuale di GnuCash.

[image: L’assistente per la nuova struttura conti]Questa immagine mostra la prima schermata dell’assistente per l’Impostazione di una nuova struttura dei conti.



La prima schermata dell’assistente fornisce una descrizione dell’assistente stesso. Premere il pulsante Avanti per procedere alla schermata successiva.

	Nella seconda schermata, selezionare dalla lista a comparsa la valuta da utilizzare per i nuovi conti. Premere poi il pulsante Avanti.
Nota
La valuta selezionata in questa fase, verrà assegnata a tutti i conti creati con questo assistente.

[image: L’assistente per l’impostazione di una nuova struttura dei conti - Valuta]Questa immagine mostra la seconda schermata dell’assistente per l’Impostazione di una nuova struttura dei conti dove è possibile selezionare la valuta.




	In the third screen, set the New Book Options,
        then press the Forward button.
        You can also update these options later using File
         → Properties.
        For details of these options, see the GnuCash
        Help manual, chapter Customizing GnuCash, Book Options.
      
[image: The New Book Options assistant]This image shows the third screen of the New
            Account Hierarchy Setup assistant where you select the
            book options.




	In the fourth screen select the Common Accounts group in the
      Categories pane. Then press the Forward button to
      proceed.
Nota
Selezionare uno o più gruppi predefiniti di conti. Per avere maggiori informazioni sui tipi di conti, consultare la sezione chiamata «Conti di GnuCash».

[image: L’assistente per la nuova struttura conti - Scelta dei conti]This image shows the fourth screen of the New
            Account Hierarchy Setup assistant where you choose the
            various accounts.




	In the fifth screen you will be able to set an Opening
      Balance on each of the accounts, as well as indicate if
      the account should be a Placeholder. As these features will be
      described in next chapters, leave all as configured by GnuCash
      and click Forward to open the last screen of the assistant.
[image: L’assistente per l’impostazione di una nuova struttura dei conti - Configurazione]This image shows the fifth screen of the New
            Account Hierarchy Setup assistant where you can set
            Opening Balance.




	Nell’ultima schermata dell’assistente, premere Applica per creare tutti i conti e uscire dall’assistente.
[image: L’assistente per la nuova struttura conti - Fine]Questa immagine mostra l’ultima schermata dell’assistente per l’Impostazione di una nuova struttura dei conti.




	Dopo aver premuto il pulsante Applica nella finestra precedente, verrà visualizzata la finestra di salvataggio. Selezionare il Formato dati XML, inserire il Nome gcashdata_1 per il file, selezionare la cartella dove salvarlo (è importante ricordarla perché questo file dei dati verrà utilizzato negli altri esempi all’interno di questa guida) e infine premere il pulsante Salva come.
La finestra principale dovrebbe ora assomigliare a questa:
[image: La finestra principale che mostra il file di prova]





Capitolo 3. Conti



Questo capitolo analizza alcuni concetti fondamentali riguardanti l’organizzazione dei conti; dato che GnuCash non impone alcun tipo di struttura dei conti, si è liberi di creare la struttura che si desidera. Esistono comunque dei concetti fondamentali che sarebbe bene seguire per ottimizzarne la fruibilità.
Concetti basilari di contabilità



As we saw in the previous chapter, accounting is based on 5 basic
    account types: Assets,
    Liabilities, Equity,
    Income and Expenses. We will now
    expand on our understanding of these account types, and show how they are
    represented in GnuCash. But first, let’s divide them into 2 groups, the
    balance sheet accounts and the income and expense accounts.
    As the name says the balance sheet accounts can be summarized in the
    balance of what you own and owe at a point in the time,
    while the income and expense accounts can be summarized in the Profit & Loss report,
    which shows the change of values in a period of time like the economic year 
Prima di procedere con l’approfondimento, si ricorda l’equazione della contabilità introdotta al capitolo precedente (attività - passività = capitale + (entrate - uscite)):
[image: La relazione fondamentale della contabilità]Visualizzazione grafica della relazione che intercorre tra i 5 tipi fondamentali di conti. Il capitale netto si accresce grazie alle entrate e diminuisce a causa delle uscite. Le freccie rappresentano la direzione del valore.



Conti di bilancio



The three so-called Balance Sheet Accounts
      are Assets, Liabilities, and
      Equity. Balance Sheet Accounts are used to track
      the things you own or owe.
Attività è l’insieme dei beni che si posseggono. Le attività possono includere l’auto, i contanti, la casa, le azioni o qualsiasi altro bene che ha un valore commerciale.
Passività è l’insieme dei debiti. Questo conto può comprendere le rate dell’auto o della scuola, un mutuo, il margine di investimento e comunque qualsiasi altro bene o servizio che prima o poi si deve ripagare.
Capitale ha lo stesso significato del valore netto. Rappresenta ciò che rimane sottraendo al valore delle attività l’ammontare delle passività. Si può anche pensare come la porzione del patrimonio sul quale non grava alcun debito e che quindi realmente si possiede.

Conti per entrate e uscite



I conti entrate e uscite vengono utilizzati per aumentare o diminuire il valore del capitale. Mentre i conti di bilancio rappresentano semplicemente il valore di ciò che si possiede e dei propri debiti, entrate e uscite permettono di variare il valore di quei conti.
Entrate rappresentano il compenso che si riceve per il proprio tempo, per i servizi che si forniscono, o per l’utilizzo del proprio denaro. Quando si riceve lo stipendio, per esempio, viene pagato il lavoro fornito al proprio datore di lavoro. Altri esempi di entrate possono essere le mance, i dividendi provenienti da azioni e gli interessi sul denaro depositato in banca. Le entrate contribuiscono sempre ad aumentare il valore delle attività e di conseguenza quello del capitale.
Expense refers to money you spend to purchase
      goods or services provided by someone else
      for early consumption. Examples of expenses are a
      meal at a restaurant, rent, groceries, gas for your car, or tickets to
      see a play. Expenses will always decrease your Equity. If you pay for
      the expense immediately, you will decrease your Assets, whereas if you
      pay for the expense on credit you increase your Liabilities.



Conti di GnuCash



Questa sezione ha l’intento di mostrare come le definizioni di conti che GnuCash propone, rientrino nei 5 tipi fondamentali.
But first, let’s begin with a definition of an
    account in GnuCash. A GnuCash
    account is an entity which contains other
    sub-accounts, or that contains transactions. Since an
    account can contain other accounts, you often see account
    trees in GnuCash, in which logically associated accounts are grouped
    together within a common parent account.
Un conto in GnuCash deve avere un nome unico (che è possibile assegnare) e una tipologie a scelta fra quelle che il programma prevede. Sono presenti, in totale, 12 tipi di conti in GnuCash basati sui 5 tipi fondamentali descritti in precedenza. La ragione per cui esistono in 
Questi conti di GnuCash sono descritti in dettaglio nel seguito.
Conti di bilancio



Il primo conto a essere esaminato è quello dello attività che, come ricordato nelle sezioni precedenti si riferisce a ciò che si possiede.
Per aiutare l’utente a organizzare il proprio patrimonio e per semplificare l’inserimento delle transazioni, GnuCash supporta diversi tipi di conti per le attività:
	liquidi: usare questo conto per registrare il denaro contante che si ha, per esempio, nel portafoglio, nel salvadanaio, sotto al materasso o dovunque si decida di tenerlo. Questo denaro è quello che viene utilizzato più facilmente;

	banca: questo conto serve a tenere traccia del denaro depositato presso delle istituzioni quali le banche, le unioni di credito, le società di risparmio o di mediazione: dovunque qualcun altro si occupa del denaro. Questo conto è secondo solamente ai liquidi come facilità di utilizzo del denaro perché può essere facilmente convertito in contanti;

	azioni: registrare le azioni e le obbligazioni utilizzando questo tipo di conto. Il registro per le azioni fornisce delle colonne aggiuntive per immettere le quote e il prezzo degli investimenti. Questo tipo di beni non si presta a essere facilmente convertito in liquidi dato che prima è necessario trovare un acquirente e inoltre non viene garantito il riottenimento per intero del capitale investito;

	fondi comuni: questo tipo di conto è simile al precedente, tranne per il fatto che deve essere utilizzato per registrare i fondi. Il registro di immissione dati prevede due colonne per l’inserimento delle quote e dei prezzi. I fondi rappresentano delle proprietà comuni di investimenti e, come le azioni, non garantiscono un valore minimo del capitale;
GnuCash treats account types Stock and
            Mutual Fund the same.
          

	crediti correnti: questo conto è dedicato tipicamente alla gestione dell’impresa e in esso vengono registrati i crediti. È considerato come un capitale dato che si dovrebbe poter contare sull’arrivo di questo denaro.
Transactions involving an Accounts Receivable account should not be added,
            changed or deleted in any way other than by using
          
	post/unpost bill/invoice/voucher or

	process payment




	Asset No matter how diverse they
          are, GnuCash handles many other situations
          easily. The account type «Asset», covers all assets not
          listed above.
GnuCash treats account types Cash,
            Bank and Asset the same.
          
I conti sono contenitori di informazioni utilizzati per tracciare e registrare tutte le azioni correlate al motivo per cui il conto è stato creato.
Per le imprese, le attività da tracciare e di cui effettuare i resoconti, sono spesso suddivise con maggiore dettaglio rispetto a quanto considerato finora. Per una discussione più approfondita delle possibilità, riferirsi alle nozioni descritte nella Capitolo 15, Altre attività di questa guida.
For personal finances a person can follow the business groupings
          or not, as they seem useful to the activities the person is tracking
          and to the kind of reporting that person needs to have to manage their
          financial assets. For additional information, consult
          Capitolo 15, Altre attività of this Guide.



Il secondo tipo di conto di bilancio è quello delle passività che, come si ricorderà, si riferisce a ciò che si deve, al denaro che si è preso in prestito e si è obbligati a restituire prima o poi dato che colui che ha prestato il denaro ha il diritto di essere ripagato. Tenere traccia del bilancio delle passività permette di conoscere in qualsiasi momento quale sia l’ammontare del proprio debito.
GnuCash permette di scegliere fra tre conti per le passività:
	carta di credito: utilizzare questo conto per registrare le ricevute e per riconciliare l’estratto conto della carta di credito. Le carte di credito rappresentano un prestito di breve durata che si è obbligati a pagare alla compagnia a cui appartiene la carta di credito. Questo conto può anche essere utilizzato per altri prestiti a breve durata;

	debiti correnti: questo è un conto utilizzato tipicamente per la gestione dell’impresa dove vengono registrati i debiti che devono ancora esser saldati;
Transactions involving an Accounts Payable account should not be added,
            changed or deleted in any way other than by using
            
	post/unpost bill/invoice/voucher or

	process payment




	  

	passività: utilizzare questo conto per tutti gli altri prestiti, generalmente di entità maggiore e di durata superiore come un mutuo o le rate dell’auto. Questo conto aiuta anche a conoscere quanto denaro si deve ancora e quanto è stato già restituito.
GnuCash treats account types Credit
            Card and Liability the same.
          



Suggerimento
Le passività in contabilità agiscono in modo opposto alle attività (o patrimonio netto): gli accrediti (avere) (valori immessi nella colonna di destra) aumentano il saldo del conto mentre gli addebiti (dare) (valori immessi nella colonna di sinistra) lo diminuiscono (consultare la nota più avanti in questo capitolo).

Il conto finale del bilancio patrimoniale è quello del capitale, che è sinonimo di valore netto o capitale netto. Rappresenta ciò che rimane dopo aver sottratto le passività dalle attività, ed è quindi la porzione di patrimonio che si possiede e sulla quale non grava alcun debito. In GnuCash si consiglia di utilizzare questa tipologia di conto come fonte per i bilanci di apertura dei conti bancari, dato che questo saldo rappresenta il valore netto iniziale.
There is usually only a single GnuCash equity account, called naturally
      enough, Equity.
      For companies, cooperatives etc. you can create a subaccount for each partner.
Suggerimento
Nel capitale netto, gli accrediti aumentano il saldo del conto e i debiti lo diminuiscono (consultare la nota più avanti in questo capitolo).

Nota
L’equazione della contabilità che lega i conti di bilancio è attività = passività + capitale o anche attività - passività = capitale. Di conseguenza, semplicemente parlando, ciò che si possiede meno ciò che si deve è uguale al valore netto.


Conti per entrate e uscite



Entrate: è il denaro che si riceve per l’impiego del proprio tempo, per i servizi che si forniscono o per l’uso del proprio denaro. In GnuCash un conto di tipo entrate è utilizzato per registrare questi guadagni.
Suggerimento
Gli accrediti aumentano il saldo del conto entrate mentre i debiti lo diminuiscono. Come descritto nella la sezione chiamata «Concetti di contabilità», gli accrediti rappresentano un trasferimento di denaro da un conto; così in questi conti speciali per le entrate, quando si trasferisce denaro dal conto entrate a un altro conto (accredito o avere), il saldo del conto entrate aumenta. Per esempio, quando si deposita un assegno e si registra la transazione come un trasferimento di denaro dal conto entrate al conto bancario, il saldo di entrambi aumenta.

Uscite: si riferisce al denaro che viene utilizzato per acquistare beni o servizi forniti da terzi. In GnuCash si utilizza un conto uscite per registrare le proprie uscite.
Suggerimento
Gli addebiti aumentano il valore delle passività mentre gli accrediti lo diminuiscono. (consulta la nota più avanti in questo capitolo).

Nota
Quando si sottraggono alle entrate totali le uscite totali in un certo periodo di tempo, si ottengono le entrate nette. Questa grandezza viene indicata nello stato patrimoniale con la dicitura utili non distribuiti, che è un tipo di conto del capitale.

Qui sotto vengono mostrati i conti standard per le entrate e per le uscite così come vengono creati scegliendo l’opzione conti comuni nell’assistente per l’impostazione di una nuova struttura dei conti (Operazioni → Nuova struttura conti...).
[image: Conti standard per le entrate]Questa immagine mostra i conti predefiniti delle Entrate



[image: Alcuni conti standard per le uscite]Questa immagine mostra alcuni conti predefiniti per le Uscite




Other Account Types



There are some special other account types.
Trading Multiple currency transactions have
        splits in «Trading» accounts to make the transaction
        balance in each currency as well as in total value. See
        Capitolo 12, Valute multiple for more information.
      
Money Market and Credit Line
        are used only in the OFX importer, apparently for
        completeness with the specification.
      


Capitolo 4. Transazioni



Questo capitolo fornisce le conoscenze necessarie per poter utilizzare le transazioni in GnuCash. Mentre i conti rappresentano l’ossatura e la struttura di un diagramma dei conti, le transazioni costituiscono i dati che completano ogni conto.
Concetti base



A transaction in a double entry accounting
    system such as GnuCash is an exchange between at least 2 accounts. Thus, a
    single transaction must always consist of at least two parts, a from and
    a to account. The from account is transferring value to the to account.
    Accountants call these parts of a transaction Ledger
    Entries. In GnuCash, they are called
    Splits.
A split identifies the account to which it refers, the
    amount of money specifically moved to or from that account, and
    can contain a few other specific pieces of information if needed.
    GnuCash supports multiple splits in a
    single transaction, and the splits can move money into or out of
    the involved accounts arbitrarily.
Per esempio, si consideri lo stipendio che si riceve e che viene depositato nel proprio conto di risparmio in banca. La transazione avviene poiché il conto di risparmio (appartenete alle attività) riceve il denaro dal conto delle entrate. Due conti sono interessati dall’operazione e, in questo caso, si verifica anche un aumento del capitale.
Le operazioni con le transazioni in GnuCash avvengono in quello che viene denominato registro contabile; a ogni nuovo conto che viene creato è automaticamente associato un registro contabile. Il registro apparirà familiare dato che è molto simile al registro per tenere traccia degli assegni.
The account register is explained in the upcoming section,
    la sezione chiamata «Il registro contabile».


Transazioni pianificate



Le transazioni pianificate sono utili per assistere nell’immissione di operazioni ripetitive con il denaro quali sottoscrizioni, assicurazioni e tasse. Utilizzando le transazioni pianificate, basta inserire la transazione in oggetto una sola volta, impostare alcuni parametri come la data di inizio, la frequenza e una breve descrizione, e poi GnuCash avvertirà ogniqualvolta sarà pronto a creare una nuova transazione oppure la creerà automaticamente.
In questa guida pratica, si considererà una sottoscrizione mensile al servizio internet di 20 Euro che viene pagata il 28 di ogni mese.
In GnuCash, si possono creare delle transazioni pianificate in due modi: dal libro mastro o dall’Editor transazioni pianificate.
Creazione dal libro mastro



Inserire nel registro la prima occorrenza della propria transazione da pianificare. Nel campo Trasferimento per questa transazione, digitare Uscite:Internet come mostrato nell’immagine seguente.
[image: Passo 1: creazione della transazione pianificata dal libro mastro]Passo 1: creazione della transazione pianificata dal libro mastro



Nota
Dato che non è ancora stato creato il conto Uscite:Internet, GnuCash ne richiederà la creazione.

Fare clic poi con il tasto destro sulla transazione e selezionare Pianifica...
[image: Passo 2: creazione della transazione pianificata dal libro mastro]Passo 2: creazione della transazione pianificata dal libro mastro



Verrà visualizzata una finestra come questa:
[image: Passo 3: creazione della transazione pianificata dal libro mastro]Passo 3: creazione della transazione pianificata dal libro mastro



Si compilino i valori richiesti; la sottoscrizione è prelevata il 28 di ogni mese e la successiva sarà per il mese prossimo (dato che quella per questo mese è stata inserita manualmente):
[image: Inserimento dei dati nella transazione pianificata]Inserimento dei dati nella transazione pianificata



Premere il pulsante OK e la transazione verrà pianificata. GnuCash ha ora memorizzato la transazione pianificata e, il 28 del mese prossimo, presenterà una finestra in cui verrà richiesto se la transazione deve essere creata (un’immagine di questa finestra è riportata qui sotto).

Creazione dalla finestra dell’Editor transazioni pianificate



Un altro modo per inserire una transazione pianificata è dalla finestra dell’Editor transazioni pianificate; questo metodo può essere più veloce se si devono creare più transazioni in una sola volta.
Dalla finestra principale dei conti selezionare Operazioni → Transazioni pianificate → Editor transazioni pianificate sulla barra del menu. Verrà così aperta una nuova scheda denominata Transazioni pianificate come quella riportata di seguito:
[image: Scheda Transazioni pianificate vuota]Scheda Transazioni pianificate vuota



Questa scheda contiene un elenco, per ora vuoto, di tutte le transazioni pianificate. Crearne una nuova premendo il pulsante Nuovo sulla barra degli strumenti; si aprirà una nuova finestra come questa:
[image: Editor transazioni pianificate window, In generale tab]Edit Scheduled Transaction
           window, Overview tab



Inserire dapprima un nome per la nuova transazione pianificata nell’apposito campo nella parte superiore della finestra.
Nota
Il nome identifica la transazione solamente nell’Editor transazioni pianificate, non apparirà mai nel registro.

Nel riquadro Opzioni della scheda Generali sono disponibili quattro opzioni:
	Attiva
	Imposta lo stato della transazione pianificata.

	Crea automaticamente
	Se abilitata, la transazione verrà inserita nel libro mastro senza che venga richiesta alcuna conferma (vedere nel seguito). Se necessario, è possibile essere avvisati al momento dell’inserimento della transazione abilitando l’opzione Notifica quando creata.

	Crea in anticipo di
	Imposta il tempo in anticipio con cui la transazione pianificata verrà creata.

	Ricorda in anticipo di
	Imposta l’anticipo con cui notificare la scadenza della transazione. È utile, per esempio, quando si deve pagare con un assegno; GnuCash può ricordare l’incombenza una settimana prima così da poter inviare l’assegno prima della scadenza.



Il riquadro Scadenze permette di dire a GnuCash che questa transazione non durerà per sempre; per esempio se si sta ripagando un prestito, si può selezionare la data di termine del prestito o il numero di rate rimanenti.
Selezionare poi la scheda della Frequenza nell’Editor transazioni pianificate. Qui è possibile impostare le opzioni relative al tempo per la transazione.
[image: Editor transazioni pianificate window, Frequenza tab]Edit Scheduled Transaction
            window, Frequency tab



	Frequenza
	Imposta la frequenza di base della transazione; selezionare un valore tra una volta,quotidiana,settimanale,quindicinale e mensile. In questo esempio verrà impostata a mensile
Nota
È possibile impostare delle scadenze a intervalli diversi da quelli elencati nell’elenco delle Frequenze, modificando le impostazioni della voce Ogni (vedere nel seguito).


	Data d’inizio
	Imposta l’inizio della transazione. Nell’esempio, questa sarà l’inizio del mese prossimo.

	Ogni
	Questa opzione permette di pianificare letransazioni in periodi multipli del valore impostato come Frequenza. Per esempio, per creare una transazione pianificata ogni 3 settimane, impostare la Frequenza a settimanale e il campo Ogni a 3.

	Poi il e a eccezione dei fine settimana
	Imposta il giorno del mese in cui è pianificata la transazione e controlla il comportamento di GnuCash quando la scadenza coincide con un giorno del fine settimana.



Nota
La sottoscrizione è prelevata il 28 di ogni mese, quindi la Data d’inizio sarà il 1° Novembre 2003 (assumendo che Novembre sia il mese prossimo) e la Frequenza sarà mensile; verrà quindi prelevata il 28 di ogni mese. Dato che nell’esempio l’abbonamento internet viene prelevato automaticamente dal conto, non sarà necessario né creare la transazione in anticipo né impostare una data finale.

Quando le voci di questa scheda sono state completate, GnuCash evidenzierà le scadenze future nel calendario sulla parte inferiore della finestra.
Infine, selezionare la scheda del Modello di transazione e inserire la transazione nella parte bassa come si farebbe nel libro mastro, con la sola differenza che non è richiesta una data.
Ora, si dovrebbe avere una finestra come questa:
[image: Editor transazioni pianificate window, Modello di transazione tab]Edit Scheduled Transaction
            window, Template Transaction tab



Si ricordi di premere il pulsante Inserisci, per convalidare e immettere la transazione.
Premendo Ok, si tornerà alla scheda delle Transazioni pianificate, ora con un elemento nella lista delle Transazioni:
[image: Transazione pianificata inserita]Transazione pianificata inserita



Suggerimento
Facendo clic nel calendario in corrispondenza del primo giorno del mese, una piccola finestra, che seguirà il mouse, mostrerà ciò che è pianificato in quel giorno. Per far scomparire la finestra è sufficiente fare clic su di essa una volta.

Ora è possibile chiudere la scheda Transazioni pianificate e salvare il proprio lavoro.
Nota
Quello mostrato di seguito è solo a titolo esemplificativo e non deve essere immesso nel file di GnuCash in questa fase. Avendo questo esempio come base, la finestra più sotto apparirà quando la transazione pianificata è impostata per essere inserita.

D’ora in poi, quando si avvia GnuCash e se è in scadenza o se deve essere inserita una transazione pianificata, potrebbe essere visualizzata la finestra Dall’ultimo avvio che riassume le operazioni pendenti relative alle transazioni pianificate (Promemoria, Da creare ecc... una descrizione di ogni opzioni è fornita nel manuale di GnuCash):
[image: Finestra di promemoria per la transazione pianificata]Finestra di promemoria per la transazione pianificata



È possibile fare clic nella colonna Stato per modificare lo stato della transazione pianificata, se necessario. Fare poi clic sul pulsante Ok per chiudere la finestra Dall’ultimo avvio... e applicare le eventuali modifiche. Selezionare Annulla per scartare le operazioni impostate.
Se il campo Stato era già (o è stato impostato) a Da creare, se si controlla nel registro del conto bancario, si noterà che la transazione è stata creata:
Suggerimento
Abilitando l’opzione Controlla le transazioni create nella parte inferiore destra della finestra Dall’ultimo avvio..., GnuCash aprirà, dopo aver premuto il pulsante Ok, la scheda del registro di ogni conto in cui sono state inserite automaticamente le transazioni pianificate.

Nota
Se la transazione per il 28 Aprile è stata inserita in questa fase, ritornare all’ultimo file salvato di GnuCash. Andare in File → Apri e selezionare gcashdata_3



In pratica



Nelle sezioni precedenti di questo capitolo sono stati discussi i concetti e la meccanica di lavoro con le transazioni di GnuCash. Questa sezione si svilupperà a partire dalla struttura dei conti creata nel precedente capitolo aggiungendo dei bilanci di apertura, delle transazioni e delle transazioni pianificate.
Aprire un file di GnuCash



Si inizi aprendo il file dei dati salvato in precedenza, gcashdata_3emptyAccts, e lo salvare come gcashdata_4 da subito. La finestra principale dovrebbe assomigliare a questa:
[image: Punto di partenza per la pratica]Questa immagine mostra il punto di partenza per questa sezione.




Bilanci d’apertura



Come mostrato per il conto Attività:Conto corrente, i bilanci di apertura di un conto sono tipicamente assegnati a un conto speciale denominato Capitali:Bilanci d’apertura. Per cominciare a popolare la struttura dei conti, si impostino i bilanci di apertura dei conti. Si assuma anche che ci siano €1.000 nei risparmi e €500 di addebito per la carta di credito.
	Aprire il registro del conto Attività:Conto risparmio. Selezionare Visualizza dal menu e controllare di aver impostato lo stile del registro a libro mastro basilare. Si vedranno le transazioni nelle altre due modalità in seguito; per ora è sufficiente creare una semplice transazione utilizzando lo stile predefinito di base.

	Dalla finestra del registro del conto Attività:Conto risparmio, inserire una semplice transazione tra 2 conti per impostare il bilancio di apertura a €1.000, trasferito da Capitali:Bilanci d’apertura. Si ricorda che una transazione semplice trasferisce denaro da un conto sorgente ad un conto di destinazione. Registrare la transazione (premere invio o fare clic sul pulsante Inserisci).

	Dalla finestra del registro del conto Attività:Conto corrente, inserire una transazione tra 2 conti al fine di impostare il bilancio di apertura a €1.000, trasferiti da Capitali:Bilanci d’apertura.

	Dalla finestra del registro del conto Passività:Visa, inserire una transazione tra due conti per impostare il bilancio di apertura a €500, trasferiti dal conto Capitali:Bilanci d’apertura. Questo si ottiene inserendo €500 come addebito nel conto Visa (o diminuzione nel conto dei bilanci di apertura), dato che si tratta di denaro chiesto in prestito. Registrare infine la transazione (premere Invio o fare clic sul pulsante Inserisci).



Si dovrebbero ora avere 3 conti con i relativi bilanci di apertura impostati: Attività:Conto corrente, Attività:Conto risparmio e Passività:Visa.
[image: Diagramma dei conti dopo aver impostato i bilanci d’apertura]Questa immagine mostra i bilanci di apertura .




Esempi di altre transazioni



Si aggiungano ora altre transazioni per simulare delle spese mensili. Durante il mese, €78 sono spesi per l’elettricità, €45 per il telefono ed €350 per l’affitto; si supponga che venga tutto pagato con il conto corrente. Si spendano inoltre €45,21 in generi alimentari, si riceva uno stipendio di €670 e si paghi una tariffa per il servizio internet. Si spostino poi €100 dal conto dei risparmi al conto corrente.
	Aprire il registro del conto Uscite:Elettricità e inserire una transazione per pagare €78 per la bolletta elettrica alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio: Società elettrica) e il numero dell’assegno (esempio: 102). Il conto di trasferimento dovrebbe essere Attività:Conto corrente.

	Aprire il registro del conto Attività:Conto corrente e inserire una transazione per pagare €45 di bolletta telefonica alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio: il nome della compagnia telefonica) e il numero dell’assegno (esempio: 103). Il conto di Trasferimento dovrebbe essere Uscite:Telefono. Si noti che è possibile inserire le transazioni sia dal lato dell’accredito (conto delle uscite) che dal lato dell’addebito (il conto delle attività).

	Aprire il registro del conto Uscite:Affitto e inserire una transazione per pagare €350 di affitto alla fine del mese corrente (esempio: 28 Marzo 2006). Inserire una descrizione (esempio: affitto Aprile) e il numero dell’assegno (esempio: 104). Il conto di Trasferimento dovrebbe essere Attività:Conto corrente.

	Si duplichi ora questa transazione utilizzando il pulsante Duplica sulla barra degli strumenti. Iniziare facendo clic nella transazione selezionata per l’affitto e premendo poi il pulsante Duplica. Inserire la data della transazione un mese più avanti (esempio: 28 Aprile 2006). Si noterà la comparsa di una linea separatrice di colore blu che GnuCash utilizza per separare le transazioni correnti da quelle future. In questo modo è possibile inserire delle transazioni prima che avvengano.
È anche possibile impostare una transazione pianificata per pagare l’affitto dato che l’importo della rata è probabilmente costante nel futuro prossimo. 
	Si inizi selezionando la transazione per l’affitto (28 Aprile) e si prema l’icona Pianifica.

	Modificare in Mensile, cambiare la descrizione se necessario e premere OK




	Per trasferire denaro dal conto dei risparmi al conto corrente, aprire il conto Attività:Conto risparmio e aggiungere una nuova transazione impostando il trasferimento a Attività:Conto corrente di un importo pari a €100 (datato 6 Marzo 2006).

	Come ulteriore esempio di semplice transazione a due conti, si aggiunga una nuova transazione per registrare un acquisto di generi alimentari per €45,21 effettuato il 5 Marzo. Dal conto Attività:Conto corrente impostare un Trasferimento a Uscite:Alimentari. Il registro del conto dovrebbe apparire così:

	Per aggiungere una transazione per la busta paga dalla finestra del registro del conto Attività:Conto corrente, selezionare una nuova riga per la transazione e fare clic sul pulsante Suddivisione. Nella prima riga inserire la descrizione della transazione (per esempio: «Employers R Us») e la data (14 Marzo). Al di sotto di questa, nella riga della «suddivisione», inserire l’importo del deposito nel conto Attività:Conto corrente (per esempio: €670). In seguito inserire i depositi per le imposte (Attività:Conto corrente (per esempio: €670), Uscite:Imposte:Statali (per esempio: €180), Uscite:Imposte:Assistenza sanitaria (per esempio: €90), Uscite:Imposte:Previdenza sociale (per esempio: €60) e, in ultimo, il totale lordo dello stipendio (per esempio: €1000) come prelievo dal conto Entrate:Stipendio.

	Si deve anche pagare la sottoscrizione internet di 20 Euro il giorno 28.



[image: Struttura dei conti dopo aver impostato tutte le varie transazioni]Questa immagine mostra il saldo finale dopo il Capitolo 4, Transazioni.




Salvare il file



Prima di procedere alla sezione sui resoconti, salvare il file di GnuCash (nome gcashdata_4).

Resoconti



Avere a disposizione i dati solo tramite lo schermo del computer non è sempre sufficiente. Per questo GnuCash mette a disposizione dell’utente un grande numero di resoconti ampiamente personalizzabili.
Si analizzeranno ora i resoconti per il Flusso di liquidi e il Resoconto delle transazioni.
	Per primo verrà analizzato il resoconto del Flusso di liquidi per il mese di Marzo.
Selezionare il resoconto dei flussi di liquidi da Resoconti → Entrate e uscite → Flusso di liquidi.
[image: Resoconto dei flussi di liquidi per il mese di Marzo]Questa immagine mostra il resoconto dei flussi di liquidi dopo il Capitolo 4, Transazioni.



Per ottenere questo resoconto personalizzato, fare clic con il tasto destro del mouse nel resoconto e scegliere Opzioni resoconto. Impostare poi il periodo e specificare quali conti si vogliono includere nel resoconto.

	Controllare ora il resoconto delle transazioni per il conto corrente.
Selezionare il resoconto delle transazioni dal menu Resoconti → Resoconto delle transazioni.
[image: Resoconto delle transazioni per il conto corrente nel mese di Marzo]Questa immagine mostra il resoconto delle transazioni per il conto corrente nel mese di Marzo.




	Cambiare ora il resoconto delle transazioni in modo da mostrare solamente i vari conti delle uscite.
[image: Resoconto delle transazioni per il conto uscite nel mese di Marzo]Questa immagine mostra il resoconto delle transazioni per i vari conti delle uscite nel mese di Marzo.








Capitolo 5. Libretto degli assegni



Questo capitolo fornisce tutte le informazioni necessarie per gestire con GnuCash il proprio libretto degli assegni. Gestire il proprio libretto degli assegni costituisce il primo passo per tenere traccia delle proprie finanze e GnuCash lo rende più facile di quanto sia mantenere un registro cartaceo.
Tanto per cominciare, come discusso nel Capitolo 4, Transazioni, l’immissione di transazioni comuni è praticamente fatta da GnuCash, grazie alla funzione di auto-completamento. GnuCash mantiene un saldo corrente per ogni conto rendendone la riconciliazione più semplice. Il metodo della partita doppia aiuta a contabilizzare le proprie spese richiedendo un conto di trasferimento per i prelievi in modo da conoscere facilmente quanto denaro è stato speso in differenti settori.
Una volta acquistata confidenza con l’utilizzo di GnuCash per il conto corrente e gli altri conti bancari, si potrebbero voler tracciare altri conti finanziari. I capitoli dal 6 al 9 esaminano i metodi per gestire gli altri conti.
Configurare i conti



Il primo passo per gestire il proprio libretto degli assegni consiste nell’impostare i conti necessari, o utilizzando quelli predefiniti di GnuCash o creandone dei nuovi. Per maggiori dettagli su come creare un nuovo conto, consultare la sezione chiamata «I conti base di livello principale». Per informazioni su come importare i conti da un altro programma, assegni consultare il manuale di GnuCash.
Per partire si avrà bisogno di diversi conti. Un conto del tipo Banca per ogni conto bancario reale di cui si desidera tenere traccia. Se si sta utilizzando una struttura dei conti personalizzata oppure quella predefinita di GnuCash, occorre assicurarsi di avere una transazione per il bilancio di apertura associata a ogni conto bancario che si possiede. Il metodo migliore per impostare questo valore, è di utilizzare come bilancio di apertura il saldo dell’ultimo estratto conto fornito dalla propria banca. È possibile inserirlo direttamente nella finestra delle informazioni del conto dell’assistente per l’Impostazione di una nuova struttura conti oppure si può inserire manualmente una transazione direttamente nel conto. In quest’ultimo caso è sufficiente creare una transazione dal conto Bilanci di apertura (della categoria capitale) al conto bancario.
I più frequenti conti bancari da includere nelle registrazioni sono:
	Conto corrente - qualsiasi conto istituzionale che fornisce la facoltà di emettere assegni.

	Conto risparmi - un conto istituzionale che matura interessi utilizzato normalmente per mantenere il denaro per tempi più lunghi rispetto al conto corrente.



Le transazioni comuni che interessano questa tipologia di conti sono i pagamenti e i depositi. I pagamenti sono trasferimenti di denaro dal conto bancario, generalmente verso un conto delle uscite. I depositi sono trasferimenti di denaro verso il conto bancario, generalmente proveniente da un conto delle entrate. È necessario impostare i conti di entrate e uscite per tracciare la provenienza e la destinazione del denaro. Si ricordi che una transazione bilanciata richiede il trasferimento di una uguale somma di denaro da almeno un conto verso almeno un conto. Così, se si deposita del denaro sul conto corrente, si deve anche indicare da quale conto il denaro proviene. Se si paga una spesa prelevando dal conto corrente, è necessario specificare il conto verso cui il denaro è stato speso.


Immettere i prelievi



Quando si preleva per una qualsiasi ragione una somma dal conto bancario, si sta trasferendo del denaro dal conto bancario verso un’altra destinazione. In GnuCash, quest’altra destinazione è registrata come un conto. Più conti di dettaglio si creano e utilizzano per le uscite, maggiori saranno le informazioni disponibili sulla destinazione del proprio denaro.
I prelievi possono assumere diverse forme. I prelievi da ATM rappresentano le transazioni più diffuse. Scrivere assegni è un altro modo per prelevare denaro al fine di pagare le bollette, per fare acquisti o per fare beneficenza. In funzione della banca, si possono avere anche costi di servizio in cui la banca preleva denaro dai conti. I trasferimenti di denaro verso un altro conto rappresentano anch’essi dei prelievi. Di seguito si tratterà ogni tipo di prelievo e se ne descriverà la procedura di inserimento in GnuCash.
ATM: prelievo di contanti



I prelievi di contanti sono trattati come trasferimenti da un conto bancario a un conto dei liquidi. GnuCash fornisce conti speciali per i Liquidi in grado di tenere traccia dei prelievi di contanti, così è necessario impostare un conto per i contanti allo scopo di registrare i propri prelievi sia con ATM che con altre modalità.
I conti per i liquidi possono essere utilizzati con diversi livelli di dettaglio. Al livello più semplice, si trasferisce semplicemente il contante dal conto corrente. Questo però indica solamente la quantità di denaro prelevata dal conto corrente in un determinato giorno, ma non fornisce informazioni sulla destinazione del denaro. Con poco impegno in più, è possibile utilizzare il conto per i liquidi per registrare anche gli acquisti in contanti in modo da poter conoscere la destinazione precisa del denaro. Questi acquisti verranno registrati come trasferimenti di denaro dal conto dei liquidi al conto delle uscite.
Alcune persone registrano ogni acquisto in contanti, ma questo richiede molto lavoro. Un metodo più semplice consiste nel registrare gli acquisti per i quali si ha una ricevuta, aggiustando poi il saldo del conto in base a quanto rimane nel portafoglio.
Si consiglia di impostare almeno un conto dei liquidi per registrare i propri prelievi. Se poi si decidesse di registrare anche la destinazione del proprio denaro, è sempre possibile inserire delle transazioni per il denaro speso. L’utente è libero di scegliere il dettaglio di livello che preferisce.


Riconciliare i conti



GnuCash rende molto semplice la riconciliazione del proprio conto bancario con l’estratto conto mensile. In la sezione chiamata «Riconciliazione» vengono fornite le istruzioni necessarie a riconciliare le proprie transazioni con l’estratto conto mensile inviato dalla propria banca. Questa rappresenta la principale operazione di riconciliazione che dovrebbe essere eseguita ogni mese.
Ma allora cosa fare di tutti i conti che sono stati creati? Dovrebbero essere riconciliati anche loro? Se si riceve un estratto conto per un determinato conto, allora sarebbe bene riconciliarlo. Degli esempi possono essere l’estratto conto del conto corrente, dei risparmi e della carta di credito. Le transazioni e l’estratto conto per la carta di credito sono descritti in Capitolo 7, Carte di credito, quindi, se si è interessati a tracciare le carte di credito con GnuCash, leggere le istruzioni contenute in quel capitolo.
I conti per le entrate e per le uscite non vengono normalmente riconciliati dato che non esiste nessun documento che permette di controllarne il saldo. Per la stessa ragione è impossibile anche riconciliare i conti del denaro liquido. Con un conto per i liquidi, però, è possibile correggere il saldo di tanto tanto, in modo che il denaro contante a disposizione corrisponda al saldo nel conto dei liquidi. L’aggiustamento del saldo è trattato nella sezione successiva.

Capitolo 6. Expense Accounts



If managing your checkbook is the first step in tracking your finances, then using expense accounts
  to see where you are expending money is a close second step. This chapter will give you an understanding of
  how GnuCash uses expense accounts to help you keep track of many different
  categories of transactions.
Concetti



An expense type account is used to allow you to track how much you spend on specific
    expenses. Technically, expense accounts are not a part of traditional accounting,
    but have become common with the increased capabilities of computer-based accounting systems.
    Many people's first experience with tracking expenses comes from Quicken(tm), where
    transactions can be assigned to one or more categories. In GnuCash, these categories
    are set up as separate accounts, which are designated as Expense type accounts.
    This allows GnuCash to apply the rules of double-entry accounting consistently.
    Expense accounts can be as detailed or as general as you need. Some users need only a few accounts for
    personal expense tracking. Others use GnuCash expense accounts to manage their expenses
    in great detail. The level of detail you choose is up to you. Keep in mind that with GnuCash,
    you can change accounts for transactions, so if your needs change later on, it is possible to move
    transactions around.


Immettere le spese



Inserire le proprie spese, fornisce un quadro più dettagliato delle proprie abitudini di acquisto. Le spese effettuate con la carta di credito sono registrate come transazioni tra il conto passività della carta di credito e l’appropriato conto delle uscite.
When you pay for goods or services with your credit card, you are telling the credit card company to pay the merchant for you. This transaction will increase the amount of money you owe the credit card company, and the credit card balance will increase. The other side of these transactions will in most cases be an expense account. For example, if you buy clothing from a store with your credit card for $50, you would be transferring that money from the credit account into Expenses:Clothing.
Entering these transactions into GnuCash allows you to track how much you owe the credit card company, as well as provides you a better picture of your overall accounts. It also allows you to monitor your account and ensure that fraud is avoided.
Adding transactions to a credit card account is similar to entering transactions in other accounts. You can enter them manually, or import them from your credit card company using a compatible import format.
For assistance with entering transactions, see Chapter 6 of the Help manual and Capitolo 4, Transazioni.

Capitolo 8. Prestiti



Questo capitolo spiega come gestire un mutuo con GnuCash.
Concetti base



Un prestito è definito come una transazione finanziaria in cui una parte paga per l’utilizzo del denaro fornito da un’altra parte. Esistono molti esempi comuni di prestiti: le carte di credito, le rate dell’auto, i mutui per la casa o un prestito per l’impresa.
Terminologia



Prima di discutere specificatamente come vengono trattati i prestiti inGnuCash, è utile presentare un glossario sulla terminologia. I termini riportati più sotto, costituiscono alcuni dei concetti base riguardanti i prestiti. Si raccomanda di prendere familiarità con questi termini o, almeno, fare riferimento a questa lista se si incontrassero dei termini non conosciuti nelle sezioni successive.
	Piano di ammortamento - il progetto di ripagamento per assicurare che il prestito verrà interamente restituito, tipicamente utilizzando delle rate mensili costanti. Questi pagamenti sono normalmente suddivisi in una parte per ripagare il principale e in una parte relativa agli interessi; l’importo del principale aumenta con l’avanzare delle rate mentre gli interessi diminuiscono.

	Debitore - l’individuo o la società che riceve in prestito il denaro.

	Insolvenza - quando il debitore non è in grado di pagare il prestito nei termini stabiliti con il creditore.

	Rinvio - un ritardo temporaneo nel rimborso di un prestito.

	Mora - è il termine che si riferisce ai pagamenti ritardati.

	Montante - importo del prestito pagato al debitore. Alcuni prestiti prevedono pagamenti multipli, nel senso che il debitore non riceve l’importo totale del prestito in una volta sola.

	Interesse - il prezzo praticato dal creditore al debitore per l’uso del denaro prestato. Generalmente si esprime in percentuale annua sul capitale prestato, denominato tasso annuo nominale o TAN.

	Creditore - la società o la persona che presta il denaro al debitore.

	Tassa per il prestito - un tassa per le operazioni prelevata dal capitale nel momento in cui il debitore riceve il prestito.

	Somma capitale o principale - l’importo originale del prestito, o l’importo del prestito originale ancora da pagare. Quando si paga una rata del prestito, una parte del denaro è per pagare gli interessi e una parte è per pagare il capitale.

	Pagherò - il contratto legale tra debitore e creditore relativo al prestito.






Riconciliazione con il resoconto del prestito (come fare)



La riconciliazione con il resoconto del prestito avviene allo stesso modo della riconciliazione di un conto bancario con l’estratto conto.
Durante tutto il periodo dovrebbero essere state registrate tutte le transazioni relative al prestito per l’auto e ognuna di esse dovrebbe aver interessato il conto Passività:Prestiti:Prestito. In pratica, il pagamento di una rata del prestito, diminuisce il saldo del conto bancario e aumenta il saldo del conto del prestito, del conto degli interessi del prestito ed eventualmente del conto delle imposte amministrative sul prestito.
Avendo sott’occhio il resoconto cartaceo del prestito, aprire il conto del prestito, avviare la procedura di riconciliazione e spuntare tutte le transazioni registrate. Al termine di questa operazione, la differenza di riconciliazione deve essere pari a 0 e, se non lo è, controllare che tutte le transazioni presenti nel resoconto cartaceo siano riportate anche in GnuCash ed eventualmente individuare le differenze. Quando finalmente la differenza è nulla, il conto è riconciliato ed è possibile terminare la riconciliazione.
Per avere maggiori informazioni sul processo di riconciliazione, consultare la la sezione chiamata «Riconciliazione»

Capitolo 11. Guadagni in conto capitale



Questo capitolo introdurrà alcune delle tecniche utilizzate per tenere traccia dei guadagni e delle perdite realizzate e non realizzate, meglio noti come guadagni o perdite in conto capitale.
Concetti base



Questo capitolo introdurrà alcune delle tecniche utilizzate per tenere traccia dei guadagni e delle perdite realizzate e non realizzate, meglio noti come guadagni o perdite in conto capitale.
Alcuni capitali re investibili possono variare il loro valore nel tempo come, per esempio, le azioni, le obbligazioni, gli immobili o le auto. Alcune attività (es: le azioni) possono aumentare in valore mentre altre (es: un’auto) posso perdere valore. È importante essere in grado di valutare queste variazioni nel valore del capitale: questo capitolo illustrerà come procedere.
Probabilmente tutto ciò che si possiede aumenterà o diminuirà il proprio valore al trascorrere del tempo; quindi è importante capire per quali di questi beni sia indicato tracciarne le variazioni del valore. Si consiglia di tracciare il valore solamente per quei beni che potranno essere venduti in futuro in cambio di liquidi o che sono relativi alle imposte.
I beni consumabili (es: il cibo, il carburante per l’auto, o la carta per la stampante) ovviamente non risultano interessati dall’argomento; inoltre, anche se il nuovo abito che si è appena acquistato perderà valore, non si desidererà tracciare questa diminuzione dato che non si avrà l’intenzione di rivenderlo e non si dovranno pagare delle imposte per la svalutazione dell’abito. Quindi, per questo esempio, l’acquisto di un nuovo abito dovrebbe essere registrato come una semplice uscita...i soldi spesi sono andati (!).
La rivalutazione (aumento del valore) di un bene avviene quando ciò che si possiede aumenta il proprio valore al trascorrere del tempo. Quando si possiede un bene che ha aumentato il proprio valore, la differenza tra il suo prezzo di acquisto e il suo nuovo valore prende il nome di guadagno non realizzato. Quando il bene viene venduto, il profitto che se ne ricava è noto con il nome di guadagno realizzato o guadagno in conto capitale. Un esempio di bene da cui è possibile avere dei guadagni non realizzati ed eventualmente dei guadagni in conto capitale, è una azione di una società pubblicamente scambiata.


Impostare i conti



Come nella maggior parte delle applicazioni della contabilità, esistono diverse metodologie per configurare i guadagni in conto capitale. Nel seguito verrà presentato un metodo generale sufficientemente versatile per essere applicato nella maggior parte delle situazioni. Il primo conto di cui si ha bisogno è quello del Costo del bene (conto di GnuCash del tipo Attività), che rappresenta la posizione in cui verrà registrato l’acquisto originale del bene. Normalmente l’acquisto avviene con una transazione dal proprio conto bancario.
Per tenere traccia della rivalutazione di un bene, saranno necessari tre conti. Il primo è un conto delle attività per i Guadagni non realizzati dove verranno inseriti tutti gli importi delle rivalutazioni. Il conto dei Guadagni non realizzati sarà bilanciato da un conto delle entrate per i Guadagni non realizzati, in cui saranno registrate tutte le rivalutazioni periodiche. Infine, è necessario un ulteriore conto per le entrate, denominato Guadagni realizzati in cui verranno registrati i guadagni in conto capitale derivanti dalla vendita del bene.
Sotto è riportata una generica struttura dei conti adatta a tracciare la rivalutazione di due beni, BENE1 e BENE2. Il conto Attività:Beni immobili:BENE1:Costo è bilanciato dal conto Attività:Attività correnti:Conto risparmio mentre il conto Attività:Beni immobili:BENE1:Guadagni non realizzati è bilanciato dal conto Entrate:Guadagni non realizzati (lo stesso discorso vale per il BENE2).


-Assets

    -Current Assets

        -Savings Account

    -Fixed Assets

        -ITEM1

            -Cost

            -Unrealized Gain

        -ITEM2

            -Cost

            -Unrealized Gain

-Income

    -Realized Gains

    -Unrealized Gains

  


Capitolo 12. Valute multiple



This chapter will show how to set up GnuCash accounts to use
  multiple currencies.
Concetti base



GnuCash supports over a hundred currencies, from the Andorran Franc
    to the Zimbabwe Dollar. For example, you can have a bank account set up in Euros, and
    another using Hong Kong Dollars.
Alcuni dei problemi che sorgono quando si utilizzano più valute, hanno a che fare con il trasferimento di fondi tra conti con diversa valuta, con il calcolo del valore totale di conti che hanno valute diverse e con la preparazione dei resoconti con valute miste.
Nota
An alternative way to manage multiple currency accounts from the one
      presented in the next sections, is to use the trading accounts
      capabilities of GnuCash. This feature, which was
      introduced with GnuCash version 2.3.14, can be enabled by
      going to the Accounts tab under File → 
      Properties.
For a complete guide on trading accounts, see
      
      this tutorial by Peter Selinger.



Recording Purchases in a Foreign Currency



Purchases in a foreign currency can be managed in two different ways.
1) Use GnuCash's built-in currency exchange functions when you
    do your transactions. This is mainly used for one-time transactions, and
    nothing which happens regularly.
2) Use separate accounts to track transactions, where all involved
    accounts use the same currency. This is the recommended method, since it
    allows much better tracking and follow up. In this way, you do one
    currency exchange transaction, and after that you do normal
    transactions in the native currency.
The rest of this section will explain more based upon option 2).
Purchase of an Asset with Foreign Currency



You are using USD as your default currency. But, you decide to purchase a
      boat in Jamaica. To do this, you opened a bank account in Jamaica, moved some
      money from the US, and then purchased your boat.
To record this in GnuCash we use the following basic account
      structure:


-Assets (USD)

   -Current Assets (USD)

      -US Bank (USD)

      -Jamaican Bank (JMD)

   -Fixed Assets (USD)

      -Boat (JMD)

-Equity (USD)

   -Opening Balances (USD)

      -USD (USD)



Note: the currency of each account is shown in parenthesis.

 

First you need to transfer some money ($10,000) to Jamaica, and
      you use your US bank account (with a balance of $100,000) for
      that. The bank gives you an exchange rate of USD 1 = JMD 64, but charges
      you USD 150 to transfer the money.
[image: Trasferimento di valuta]Trasferimento di denaro in Jamaica



Selezionare la riga della transazione in Jamaica (€9.850,00), premere il tasto destro del mouse e selezionare Modifica tasso di cambio
[image: Modifica tasso di cambio]La finestra in cui viene specificato il tasso di cambio per una transazione in valuta



As Exchange Rate, you enter 1 USD = 64 JMD, since this is the rate
      your bank gave. Press ok in the Transfer Funds (Edit Exchange Rate)
      window, and then save this split transaction. Below is how it now looks
      in the main Chart of Accounts.
[image: Struttura dei conti prima dell’acquisto della barca]Struttura dei conti prima dell’acquisto della barca



You choose to buy a boat for JMD 509,000. To record this transaction 
      in GnuCash, you will need to enter a simple 
      transaction in Assets:Current Assets:Jamaican Bank
      withdrawing JMD 509,000 and transferring it to Assets:Fixed Assets:Boat
[image: Struttura dei conti dopo l’acquisto della barca]Struttura dei conti dopo l’acquisto della barca



The Chart of Accounts now reflects that your bank account has been
      reduced by JMD 509,000, and that your Fixed Assets boat account has been 
      increased by the same amount. If you also have turned
      on the CoA (Column Choice) "Total (USD)" you will see the corresponding
      value in USD. The USD value will always reflect the latest currency exchange
      rate you have either automatically or manually retrieved.

Purchasing Foreign Stocks



This example will show how to purchase stocks that are priced in a
      currency other than your primary currency.
Assume that you live in New York and therefore you have set the
      default currency to USD. You decide to purchase a stock traded in Hong
      Kong that is priced in HKD. You would also like to be able to track the
      various income and expense amounts per stock and broker.
You decide to purchase stock in the Beijing Airport (Hong Kong). 
      The ticker for this stock is 0694.HK on Yahoo! Since you wanted to 
      track all various income and expense amounts, here is the necessary
      account structure:


Assets:Investments:Brokerage Accounts:Boom:0694.HK (0694.HK)

Assets:Investments:Brokerage Accounts:Boom:Bank (HKD)

Equity:Opening Balances:HKD (HKD)

Expenses:Commissions:Boom.0694.HK (HKD)

Income:Investments:Dividend:Boom:0694.HK (HKD)

      

La struttura dei conti assomiglia a questa dopo la creazione di tutti i conti necessari:
[image: Struttura dei conti per azioni internazionali]Struttura dei conti per azioni internazionali



Le informazioni sull’azione sono visualizzabili nell’editor titoli (Strumenti+Editor titoli):
[image: Titoli Internazionali]Titoli Internazionali



If you have not moved money (HKD 50,000) into the brokerage
      cash account (Assets:Investments:Brokerage Account:Boom:Bank), do so
      now, either using the Equity (HKD) account, or an existing bank account
      (Currency Transfer).
There are two ways to enter the actual purchase transaction: you can
      enter it from the cash account (shown below), or you can enter it 
      from the stock account. If entered from the stock account, the stock is 
      assumed to be priced in the currency of the parent account.
Let’s assume that the stock price is HKD 3 per share. To record the
      purchase, open the brokerage’s HKD cash account
      (Assets:Investments:Brokerage Account:Boom:Bank), and enter
      the following:
Buy Stocks
	Assets:Investments:Brokerage Account:Boom:Bank	Prelievo	50,000
	Expenses:Investments:Commission:Boom_HKD	Deposito	500
	Assets:Investments:Brokerage
	Account:Boom:0694	Deposito	49,500
	(16,500 shares)


Se non viene visualizzata automaticamente la finestra del Tasso di cambio, fare clic con il tasto destro del mouse nella riga dell’azione e selezionare Modifica tasso di cambio. Nella finestra che verrà aperta, inserire il numero di azioni (16.500) nel campo Trasferisci a:
[image: Trasferimento di fondi]Impostazione del numero di quote nella finestra del trasferimento fondi



When you return to the Chart of Accounts, you will see the
      purchased shares reflected in the stock account’s total.
[image: Azioni Internazionali acquistate]Struttura dei conti con alcune azioni Internazionali



Come si può vedere, il totale in Euro potrebbe essere zero se non è stato impostato alcun tasso di cambio tra EUR e HKD. Per porvi rimedio, andare in Strumenti → Editor prezzi e premere il pulsante Ricevi quotazioni per far sì che GnuCash recuperi automaticamente i vari tassi di cambio di cui si ha bisogno.
Nota
To reiterate, this example shows how stock can be purchased in any currency
         by entering the transaction in the register of the cash account used
         to make payment. It is also possible to enter the purchase
         in the stock account’s register, but be aware that the stock is 
         assumed to be priced in the currency of the stock account’s parent.
In questo esempio, il conto padre (Attività:Investimenti:Conto brockeraggio:Boom) è impostato in HKD. Dato che si tratta della stessa valuta con cui viene espresso il prezzo dell’azione, l’acquisto può essere inserito tranquillamente nel registro del conto dell’azione.



Tracking Currency Investments



Currency investment is when you decide to invest in a different
    country's currency, and hope that it will rise in value
    relative your own currency.
When you enter these transactions into GnuCash, you will have to
    decide on how much detail you would like to have.
If you are not interested in detail at all, a very simple account
    structure would suffice:


    Assets:Investments:Currency:Bank (USD)

    Assets:Investments:Currency:XXX (XXX)

    

You would simply enter transfers between the two accounts, noting 
    exchange rates as you went.
But, if you do want to be able to track capital gains or losses,
    as well as any fees, you do need a more complex account structure, such as:


    Assets:Investments:Currency:Bank (USD)

    Assets:Investments:Currency:Currency Bank:XXX (XXX)

    Expenses:Investments:Currency:Currency Bank:XXX (XXX)

    Income:Investments:Currency Bank:Capital Gains:XXX (XXX)

    

Purchasing Currency



When purchasing another currency, you will buy a certain number of 
      units of foreign currency with your own currency, at a particular rate.
      For example, you might buy USD 10,000 worth of Andorran Francs, at 5 Francs
      to the dollar, with a transaction fee of $150.
Buy Currency
	Attività:Investimenti:Valuta:Banca	Prelievo	10,000
	Expenses:Investments:Currency:Currency Bank:ADF	Deposito	150
	Assets:Investments:Currency:ADF	Deposito	49,250


The Exchange Rate window should pop up when you
      leave the last row in the split above (Currency Transaction). If this
      window does not pop up, right click on the row or select 
      Actions, and select Edit
      Exchange Rate. In the Exchange Rate window you specify the
      exchange rate you got from the bank.

Vendere un investimento in valuta



Entering a currency sale is done in the same way as
      a currency buy except that you are now transferring money from the Currency
      account to your Savings account (very similar to la sezione chiamata «Vendere le azioni»).
The proper recording of the currency sale *must* account for realized
      gains or losses. This can be done using a
      split transaction. In the split transaction, you must account for the
      profit (or loss) as coming from an Income:Capital Gains account (or
      Expenses:Capital Loss). To balance this income, you will need to enter
      the Currency asset twice in the split—once to record the actual sale
      (using the correct amount and correct exchange rate), and once to balance
      the income profit (setting the amount to 0).
In breve, una transazione di vendita per la valuta, dovrebbe assomigliare a quella riportata più sotto, vista di nuovo dal conto Attività:Investimenti:Valuta:Banca.
Tabella 12.1. Schema per la vendita di valuta con una transazione suddivisa
	Conto	Deposito	Prelievo
	Attività:Investimenti:Valuta:Banca	Importo venduto - Imposta di cambio	 
	Uscite:Investimenti:Valuta:Valuta Banca:XXX	Imposta di cambio	 
	Attività:Investimenti:Valuta:XXX	 	Importo venduto
	Entrate:Investimenti:Valuta Banca:Guadagni in capitale:XXX	[PERDITA]	UTILE
	Attività:Investimenti:Valuta:XXX	PROFITTO (con trasferisci a = 0)	[PERDITA (con trasferisci a = 0) ]






Reconciling Statements in a Foreign Currency



Reconciling foreign statement are done in the same manner as when
    you reconcile your local bank statement. If you have created a Chart of
    Accounts structure which allows you to have the same currency per account
    as your statement, it is actually exactly the same as
    reconciling your local bank statement.
Se si hanno diverse valute, si dovranno convertire manualmente gli importi tra una valuta e l’altra, mentre si riconciliano i conti.

Capitolo 13. Business Features



Introduction to Business Features



Le necessità contabili di un’impresa sono evidentemente differenti da quelle di un singolo individuo. Le imprese devono gestire i clienti (che sono debitori di denaro), i fornitori o venditori (che sono creditori), i libri paga dei dipendenti, una legislazione delle imposte più complessa, ecc... GnuCash offre delle funzioni dedicate all’impresa per venire incontro a queste necessità.
Accounts Receivable (A/R) are used by businesses to record sales for
        which they are not immediately paid. This is represented on the balance sheet as an asset,
        because the expectation is that you will receive payment soon.
      
Accounts Payable (A/P) record bills that businesses have received, but may not pay until later.
        This is represented on the balance sheet as a liability because you will have to pay for them.
      
A/R and A/P accounts are used primarily when you have a lot of bills and receipts
        flowing in and out, and do not want to lose track of them just because you
        do not pay or get paid right away. For most home users, A/R and A/P are
        too complicated to be worthwhile.
      


Crediti correnti



Per crediti correnti si intendono quei prodotti o servizi forniti dalla propria società e per i quali non è ancora stato ricevuto il pagamento.
Componenti del sistema



Transactions generated by the A/R system are recorded within the Accounts
                Receivable account. You should not work directly with this account.
                Instead, you will work with the four integrated GnuCash A/R application
                components available through the Business → Customer sub-menu. These four components are:
	Cliente è un singolo o una società a cui sono stati venduti prodotti o servizi in credito.

	Fattura rappresenta il documento cartaceo inviato al cliente per richiedere il pagamento. Essa contiene una lista dettagliata degli oggetti venduti.
In addition, GnuCash also has support for Credit Notes
                        which represent the inverse of Invoices. A credit note is usually handed to
                        a customer to correct items that were incorrectly invoiced or returned.
Both document types will be set up using the same menu items. Credit notes were introduced starting with
                        GnuCash stable release 2.6.0.
                    

	Lavoro (opzionale) qui vengono registrati i lavori relativi al cliente. Un lavoro in GnuCash è un meccanismo attraverso il quale è possibile raggruppare diverse fatture relative a un particolare cliente.

	Procedura di pagamento permette di registrare i pagamenti ricevuti da un cliente.




Cliente



Per cliente si intende un singolo o una società alla quale vengono venduti beni o servizi. Il cliente deve essere registrato nel sistema dei crediti correnti.
Registrare un nuovo cliente



To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer information, such as
                Company Name, Address, Phone, Fax, etc.
[image: Finestra di registrazione di un nuovo cliente]Finestra di registrazione di un nuovo cliente




Trovare e modificare un cliente



Per trovare un cliente, utilizzare la funzione Impresa → Cliente → Trova cliente. È poi possibile selezionare, dalla finestra dei risultati, un cliente da Visualizzare o modificare. Questa finestra è anche utilizzata per selezionare un cliente quando si crea una nuova fattura e quando si procede a un pagamento.
[image: Finestra di ricerca del cliente]Finestra di ricerca del cliente



Se dalla ricerca vengono restituiti molti elementi corrispondenti, è possibile filtrare i risultati eseguendo una ulteriore ricerca tra questi ultimi. Il gruppo dei risultati attuali viene analizzato quando è selezionata l’opzione Perfeziona la ricerca attiva. GnuCash rende disponibile questa opzione solamente dopo che è stata eseguita con successo la ricerca iniziale.
Se il cliente che si sta cercando non è stato trovato con il criterio di ricerca inserito, è possibile cambiare il criterio di ricerca e selezionando l’opzione Nuova ricerca seguita dal pulsante Trova. Il passo più importante è la selezione dell’opzione Nuova ricerca. Se il venditore non è tra i risultati della ricerca originale e si effettua una ricerca tra i risultati ottenuti, il venditore non verrà trovato anche se il criterio di ricerca è stato cambiato.
Nota
Per visualizzare una lista dei clienti attivi, si imposti il criterio di ricerca a corrisponde all’espressione regolare e inserire un singolo punto . nel campo del testo da ricercare. Assicurarsi che non sia selezionata l’opzione Cerca solo tra i dati selezionati, poi premere Trova. L’espressione regolare . significa trova tutto.



Fattura



Una fattura è il documento cartaceo che si invia a un cliente per richiedere il pagamento di prodotti o servizi prestati. GnuCash è in grado di creare e di registrare le fatture.
A credit note is the paperwork you send to a customer to correct
                products or services rendered that were incorrectly invoiced. GnuCash can generate and track
                credit notes via the same menu entries as invoices.
Nota
This section applies to both invoices and
                    credit notes. In order to avoid repeating everything twice and to keep
                    the text easier to read it will refer only to invoices. You can apply
                    it equally to credit notes. Only where the behavior of credit notes
                    differs from invoices this will be explicitly mentioned.

Registrare un nuovo cliente



To send an invoice to a customer you must first create the new
                    document. To create an invoice use Business → Customer → New Invoice. The
                    New Invoice window must be filled in appropriately.
[image: Creazione di una nuova fattura]Creazione di una nuova fattura



Quando si preme il pulsante OK, verrà aperta la finestra di Modifica fattura.

Modificare una fattura



From the Edit Invoice window you can enter an itemized list of
                    goods and services you sold on this invoice in a manner similar to how the account
                    register works. For credit notes you enter an itemized list of goods and
                    services you refunded instead.
[image: Finestra di modifica della fattura]Finestra di modifica della fattura



Quando sono state inserite tutte le voci, si può Emettere e stampare la fattura.

Emettere una fattura



Quando è terminata la fase di modifica di una fattura e si è pronti a stamparla, è necessario Emettere la fattura. Non è necessario emettere la fattura immediatamente; in fatti, la fattura deve essere emessa solamente quando si è pronti a stamparla. L’emissione di una fattura prevede l’inserimento automatico delle transazioni necessarie nel conto dei crediti correnti.
[image: Finestra di emissione della fattura]Finestra di emissione della fattura




Trovare una fattura



To find an existing invoice, use the Business → Customer → Find Invoice
                menu item. From the results of the search, you can select an invoice
                    to edit or view.
Nota
Prima di poter modificare una fattura emessa, sarà necessario Annullarla.

Uno degli obiettivi di progetto del sistema di gestione dei crediti correnti presente in GnuCash, era quello di fornire diverse strade per raggiungere una stessa posizione a seconda del metodo con cui si idealizza il problema:
	si può cercare prima il cliente, e poi visualizzare le fatture a esso associate;

	si può cercare una fattura per numero o per nome della società;

	si possono visualizzare le fatture associate a un lavoro cliente.




Stampare una fattura



Dopo aver emesso una fattura, può essere utile stamparla e inviarla al cliente. Per stampare una fattura, utilizzare la voce del menu principale File → Stampa fattura.
[image: Risultato di stampa della fattura]Risultato di stampa della fattura



Nota
È possibile modificare l’aspetto della fattura inserendo, per esempio, il logo della società ecc... Per le istruzioni su come farlo, vedere la la sezione chiamata «Cambiare l’aspetto della fattura».

Le fatture possono essere anche stampate dalla finestra principale selezionando la voce del menu Resoconti → Resoconto impresa → Fattura stampabile. La finestra del resoconto avviserà che non è stata selezionata una fattura valida per la stampa. Per selezionarla procedere come segue:
	Utilizzare il pulsante Opzioni della barra degli strumenti o selezionare Modifica → Opzioni resoconto dal menu principale.

	Selezionare la scheda Generale della finestra delle opzioni del resoconto.

	Premere il pulsante Seleziona a fianco del campo del Numero fattura.

	Cercare la fattura come al solito.



È inoltre possibile stampare le fatture direttamente dalla finestra della procedura di pagamento. Consultare la la sezione chiamata «Procedere al pagamento» per le istruzioni su come procedere.

Assegnare un numero iniziale alla fattura



GnuCash parte automaticamente con il numero 1 e ne incrementa poi il valore. È possibile inserire manualmente un numero di fattura nella casella di testo ogni volta che viene creata un nuova fattura, ma questa operazione può essere ripetitiva e prima o poi si arriverà a inserire dei numeri duplicati.
You can change the starting invoice number if it is important you.
                    Use File → Properties, access
                    the Counters tab, change the Invoice number value to be
                    one less than your desired starting invoice number and click the OK button or the
                    Apply button.


Lavori per un cliente



Customer Jobs are used to group multiple invoices and credit notes to the same
                customer. Use of the Customer Jobs feature is optional. The feature is
                useful when you have multiple jobs for the same customer, and would like
                to view all the invoices and credit notes related to a single job.
[image: Nuovo lavoro per un cliente]Nuovo lavoro per un cliente



To use customer jobs, you must create them using the Business → Customer → New Job menu item. You will see the New
                    Job window.
To edit an existing customer job, use the Business → Customer → Find Job menu item. Select the desired job in the
            search results, and click the View/Edit Job
                button.
To select from the invoices and credit notes associated with a given job, use Business → Customer → Find
                    Job menu item. Select the desired job in the
            search results and click the View Invoices button. A
            window listing invoices and credit notes associated with this job appears. Select an
            invoice or credit note and click the View Invoice button to open an
                invoice editor in the main application window.

Procedere al pagamento



Verosimilmente, si riceverà il pagamento dai clienti per i quali è stata emessa una fattura. Per registrarlo, si utilizza la procedura di pagamento raggiungibile dal menu Impresa → Cliente → Procedura di Pagamento.
[image: Procedere al pagamento]Finestra della procedura di pagamento




Cambiare l’aspetto della fattura



Lo stile predefinito per le fatture, come mostrato nella la sezione chiamata «Stampare una fattura», à piuttosto spoglio. Esso prevede che la parte superiore del documento sia vuota, in modo che la fattura possa essere stampata su carta intestata. È però possibile modificare l’aspetto delle fatture.
Utilizzare la voce File → Proprietà per inserire le informazioni relative alla propria società nella scheda Impresa della finestra Opzioni libro. Alcune delle informazioni inserite verranno stampate sul lato destro delle fatture.
Per aggiungere uno sfondo, uno striscione di intestazione e un logo personalizzati alle fatture, occorre modificare il foglio di stile. Per farlo, andare in Modifica → Fogli di stile e selezionare il pulsante Nuovo nella finestra di Selezione del foglio di stile HTML che si aprirà. Verrà poi presentata una finestra come questa:
[image: Finestra del nuovo foglio di stile]La finestra del nuovo foglio di stile.



Dare un Nome al nuovo foglio di stile (ad esempio Fattura personalizzata) e selezionare il Modello denominato Elaborato. Alla pressione del pulsante OK verrà aperta la finestra delle Proprietà dei fogli stile HTML. Questa contiene cinque schede: Colori, Stili, Generali, Immagini e Tabelle. La prima scheda relativa ai colori permette di variare la colorazione delle varie sezioni che compongono la fattura. La sezione deegli stili permette di impostare gli stili e le dimensioni dei caratteri. La scheda delle impostazioni generali è dedicata alle informazioni del redattore e del destinatario e permette di abilitare i collegamenti. La scheda delle immagini permette di importare delle immagini nel foglio di stile. Infine, la schede delle tabelle, permette di configurare la spaziatura tra le tabelle che formano la fattura.
Per inserire un logo della società, uno striscione di intestazione e una immagine di sfondo, è possibile utilizzare un’applicazione di grafica come GIMP o OpenOffice Draw per creare l’immagine e salvarla in formato GIF o PNG. A questo punto è possibile importarle nel foglio di stile utilizzando la sezione Immagini descritta in precedenza.
Qui sotto è visualizzato un esempio in cui sono state importate tutte e tre le immagini.
[image: Esempio di fogli di stile HTML]La finestra del foglio di stile HTML con un esempio di immagine di sfondo, striscione di intestazione e logo.



Nota
Le immagini sono inserite nella fattura con i criteri seguenti: l’Immagine di sfondo è adattata per essere inserita come sfondo, lo Striscione di intestazione viene inserito al di sopra del testo della fattura e il Logo è posizionato nell’angolo in alto a sinistra della fattura a fianco dello striscione di intestazione. Sarà probabilmente necessario provare immagini di dimensioni diverse prima di ottenere una bella fattura. Vengono forniti alcuni suggerimenti su questo argomento: il logo dovrebbe essere di circa 1 cm quadrato mentre lo striscione di intestazione dovrebbe essere largo 15 cm e alto 1cm.

Avendo configurato il foglio di stile, al momento della stampa della fattura sarà possibile selezionarlo dal menu Opzioni. Più sotto è riportata la fattura ottenuta dopo aver utilizzato il foglio di stile descritto precedentemente.
[image: Esempio di fogli di stile HTML]La fattura che si ottiene con le immagini selezionate nel foglio di stile.





Capitolo 14. Bilanci



Questo capitolo spiega come creare e gestire i bilanci con GnuCash.
Concetti base



Il bilancio è uno strumento che permette di stimare e prevedere le entrate e le uscite. Si può utilizzare per aiutarsi nella pianificazione delle proprie finanze in un certo periodo di tempo e per esaminare come sono le proprie transazioni finanziarie attuali in confronto a quelle attese.
Il concetto di bilancio è generale e quindi GnuCash offre uno strumento di calcolo del bilancio che è semplice e flessibile. L’utente ha la libertà di decidere la complessità o la semplicità del proprio bilancio. Questa guida aiuterà nella scelta di queste decisioni.
Terminologia



Esistono dei termini utili che verranno utilizzati per trattare l’argomento del bilancio:
	Bilancio - un piano finanziario che descrive i redditi attesi e/o le spese relative ad un particolare periodo di tempo period

	Bilancio dei liquidi - un bilancio preventivo per gli introiti e gli esborsi di liquidi. Questio tipo di bilanciosi occupa dei flussi di liquidi: da dove proviene il proprio denaro, qual’è la sua destinazione e, naturalmente, a quanto ammonta.

	Bilancio delle uscite - un bilancio destinato principalmente alla pianificazione delle destinazioni del proprio denaro. Questo tipo di bilancio registra le proprie uscite. Generalmente non ha niente a che vedere con le rivalutazioni o con i rimborsi delle passività. Comunque, tiene conto degli interessi. Per esempio, se si acquistano €100 di alimentari con la carta di credito, si incorre in una spesa di €100 per alimentari e una passività di 100€ verso la compagnia della carta di credito. Quando si pagherà la ricevuta della carta di credito, verrà applicato un tasso di interesse che si suppone dia origine ad una spesa addizionale di €10. Un bilancio delle uscite è in grado di pianificare la transazione per l’acquisto degli alimentari e per il pagamento degli interessi, ma non la transazione per ripagare la compagnia della carta di credito.

	Bilancio di capitale - un bilancio che descrive un piano per pagare una ingente spesa futura, spesso attraverso una combinazione di risparmi e prestiti in denaro. Nota: i bilanci di capitale possono a volte divenire piuttosto complessi perché hanno anche lo scopo di rispondere alla domanda «è possibile permettersi di fare questo e quello?» esplorando diversi scenari che coinvolgono conti ipotetici.

	Periodo di bilancio - il periodo di tempo durante il quale il piano si sviluppa. I periodi di bilancio più comunemente utilizzati sono l’anno e il mese. Alle volte, potrebbe essere utile fare il bilancio per diversi periodi consecutivi in una volta, per convenienza o per una pianificazione più dettagliata. Ad esempio, un bilancio annuale può includere un periodo di bilancio di 12 mensilità.






Creare un bilancio



Ancora prima di iniziare la creazione di un bilancio, è importante spendere un po’ di tempo pensando alla struttura dei conti. Per esempio, se si desidera ottenere un bilancio per le proprie spese di elettricità e acqua, non è possibile avere solamente un conto Uscite:Servizi. I conti devono essere dettagliati almeno quanto il bilancio che si vuole ottenere.
Scegliere i conti per i quali creare il bilancio



Il primo passo da compiere nella creazione di un bilancio, consiste nello scegliere che cosa di desidera pianificare. Questa decisione influisce sulla scelta dei conti da includere nel bilancio. Ad esempio, se si è interessati solamente al tracciamento delle proprie spese, si può creare un bilancio delle uscite inserendo solamente gli importi dei conti delle uscite. D’altra parte, se si desidera tracciare tutti i propri movimenti di liquidi, si può creare un bilancio dei flussi di liquidi immettendo gli importi dei conti di attività, passività, entrate e uscite.
Prima di procedere alla creazione del bilancio occorre prendere due decisioni: per quali conti si desidera ottenere un bilancio? e, per quando si desidera che venga calcolato il bilancio? È sempre possibile cambiare idea in seguito dopo la creazione del bilancio, ma è necessario iniziare con qualcosa.
Suggerimento
Come regola generale, spesso interessa conoscere in cosa si spende il proprio denaro e quindi si potrebbe voler realizzare un resoconto delle uscite. Se si è anche preoccupati di non avere abbastanza denaro al posto giusto nel momento giusto, si potrebbe voler realizzare un bilancio dei flussi di liquidi.


Scegliere il periodo di bilancio



Prima di creare un bilancio occorre anche decidere per quale periodo di tempo si desidera pianificare. I periodi di bilancio più comuni sono mensilmente e annualmente. Se si desidera realizzare un bilancio il cui percorso finanziario nel tempo sia variabile, allora sarebbe necessario includere diversi periodi nel bilancio. Ad esempio, se si desidera pianificare delle spese maggiori per i servizi nel periodo invernale piuttosto che in quello estivo, allora si potrebbe voler suddividere il bilancio annuale in 4 trimestri o anche in 12 mesi, e mettere nel bilancio un valore superiore per il periodo invernale e uno inferiore per quello estivo.

Come Iniziare



Per creare il primo bilancio selezionare Operazioni → Nuovo → Nuovo bilancio preventivo. Verrà immediatamente visualizzato un nuovo bilancio con le impostazioni predefinite e nessun elemento. Selezionare poi il pulsante Opzioni. Le opzioni più importantii sono quelle relative al periodo e al numero di occorrenze. Per il periodo del bilancio, selezionare la data d’inizio e il periodo di tempo più corto per il quale si vuole effettuare il conteggio. Poi selezionare il numero di occorrenze.
La pagina del bilancio mostra ora una lista di conti con una colonna per ogni periodo di bilancio. La data visualizzata nel titolo di ogni colonna rappresenta l’inizio di quel periodo di bilancio.

Inserire i valori di bilancio



Ora si devono inserire i valori di bilancio cioè gli importi che ci si aspetta che i saldi dei conti assumano durante il periodo di bilancio. I valori di bilancio possono essere inseriti in due modi: il primo consiste nel fare clic direttamente nella cella di interesse e inserire un importo.
Se si hanno a disposizione delle transazioni inserite in GnuCash, il secondo metodo consiste nel far stimare a GnuCash i valori di bilancio sulla base di queste transazioni. Prima, selezionare il conto che si desidera far stimare a GnuCash; poi, premere il pulsante Stima sulla barra degli strumenti. Nella finestra di Stima dei valori del bilancio, selezionare la data dopo la quale GnuCash dovrà controllare le transazioni. GnuCash inizierà da questa data e controllerà nel seguito per il periodo di durata del bilancio. Ad esempio, se si sta facendo un bilancio annuale e si sceglie come data il 1° Gennaio 2005, GnuCash controllerà tutte le transazioni in quel conto dal 1° Gennaio 2005 al 31 Dicembre 2005.


Capitolo 16. Deprezzamento



Questo capitolo introdurrà i concetti di deprezzamento (o svalutazione) in contabilità e fornirà alcuni esempi reali di utilizzo.
Concetti base



La svalutazione è il metodo contabile per spendere gli acquisti di capitale nel tempo. Esistono due motivi per cui si potrebbe voler registrare il deprezzamento: si sta tenendo la contabilità delle proprie finanze personali e si desidera tenere traccia del valore netto oppure si sta tenendo la contabilità di una piccola impresa e si ha la necessità di produrre un documento finanziario dal quale si dedurranno le detrazioni fiscali.
Il metodo di registrazione della svalutazione è lo stesso in entrambi i casi ma lo scopo finale è diverso; in questa sezione verranno discusse le differenze fra i due Prima di tutto si riportano dei termini di utilizzo comune trattando di deprezzamento.
	Deprezzamento accumulato - il totale cumulato del deprezzamento avvenuto nella vita di un bene. Esso viene accumulato nel conto di deprezzamento nella sezione del bene.

	Deprezzamento contabile - è l’importo del deprezzamento che viene registrato sui documenti finanziari per un periodo contabile.

	Giusto valore di mercato - l’importo per il quale un bene può essere venduto a una data precisa.

	Valore netto registrato - è la differenza fra il costo originale di acquisto del bene e il deprezzamento a una certa data.

	Costo originale - è l’importo di denaro con cui è stato acquistato il bene. Sono inclusi in esso tutti i costi necessari a rendere utilizzabile per i propri scopi il bene. Per esempio: spedizione, costi di installazione, addestramenti speciali ecc...

	Valore di recupero - è il valore al quale si stima che il bene possa essere venduto al termine della sua vita utile (per il proprio utilizzo).

	Ammortamento fiscale - è l’importo del deprezzamento utile per individuare il valore del reddito imponibile per l’applicazione delle imposte.



Finanze personali



Il deprezzamento è utilizzato nelle finanze personali per far diminuire periodicamente il valore di un bene al fine di avere a disposizione una stima accurata del valore netto corrente. Per esempio, se si possiede un’auto, è possibile tener traccia del suo valore attuale registrando il deprezzamento ogni anno. Per farlo, è necessario registrare il prezzo di acquisto originale come un’attività e poi registrare un’uscita relativa alla svalutazione (consultare la sezione chiamata «Esempio» per vedere un esempio). Così facendo il valore netto contabile sarà approssimativamente uguale al giusto valore di mercato del bene alla fine dell’anno.
Depreciation for personal finance has no tax implications, it is
      simply used to help you estimate your net worth. Because of this, there
      are no rules for how you estimate depreciation, use your best
      judgement.
Per quali beni si dovrebbe stimare la svalutazione? Dato che lo scopo del deprezzamento per le finanze personali è quello di fornire una stima del valore netto dei propri beni, si consiglia di registrare la svalutazione solamente per quei beni che hanno un valore rilevante e che un giorno si potrebbe desiderare rivendere come, per esempio, un’auto o una barca.

Impresa



Al contrario delle finanze personali dove lo scopo è quello di tracciare il valore dei beni personali, le imprese devono far corrispondere le spese di acquisto di un bene capitale con la rendita che questo può fornire; questo è possibile solo con la registrazione della svalutazione. Le imprese hanno anche a che fare con le leggi sulle imposte che trattano il deprezzamento; questo prende il nome di ammortamento fiscale. L’impresa è libera di scegliere qualsiasi schema desideri per registrare il deprezzamento, ma lo schema utilizzato per l’ammortamento fiscale è fisso. Spesso questo comporta delle differenze tra svalutazione contabile e ammortamento fiscale, ma è possibile prendere dei provvedimenti per ridurre questo effetto.
Quali acquisti dovrebbero essere capitalizzati? se si prevede che un bene acquistato possa fornire delle entrate per un tempo superiore all’anno corrente, allora dovrebbe essere capitalizzato. In questa definizione ricadono quindi i beni quali i terreni, gli edifici, le attrezzature, le auto e i computer (se vengono tutti utilizzati per lavoro). Non sono compresi i beni che possono considerarsi come scorte. Così, se si acquista un bene con l’intento di rivenderlo, non dovrebbe essere capitalizzato.
Oltre al prezzo di acquisto del bene in sé stesso, qualsiasi costo sostenuto per rendere utilizzabile il bene, dovrebbe essere capitalizzato. Per esempio, se si acquista un’attrezzatura che deve essere spedita fuori città, che necessita di lavori elettrici per l’installazione e di corsi specifici sul suo utilizzo, tutti questi costi potranno essere inclusi nel costo dell’attrezzatura.
È anche necessario conoscere il valore di recupero del bene che, solitamente, viene assunto pari a zero. Il bisogno di conoscere il valore di recupero deriva dal fatto che il bene sarà deprezzato fino a quando il valore netto contabile (costo meno deprezzamento) sarà pari al valore di recupero. Così, quando il bene sarà tolto dal registro, non si avranno perdite o guadagni derivanti dalla cessione del bene.
L’ultimo passo consiste nell’individuare il metodo di svalutazione da utilizzare. Questo argomento verrà discusso nelle pagine seguenti.
Nota
ATTENZIONE: si presti attenzione al fatto che diversi Paesi possono avere politiche sulle imposte sostanzialmente diverse per quanto riguarda il deprezzamento; questo documento fornisce solamente delle nozioni di base in modo che poi ognuno possa applicare la politica sulle imposte e sul deprezzamento che interessa nel caso specifico.




Esempio



Si immagini di essere un fotografo e che quindi si debba utilizzare un’auto e una costosa macchina fotografica per il proprio lavori. Sarà utile tenere traccia della svalutazione di questi beni dato che sarà probabilmente possibile dedurre la svalutazione dalle imposte sulla propria attività.
Il primo passo consiste nella costruzione della struttura dei conti (come mostrata nella sezione precedente, sostituendo a BENE1 e a BENE2 «auto» e «macchina fotografica»). Ora, è possibile registrare l’acquisto dei beni trasferendo il denaro dal proprio conto bancario al relativo conto del costo del bene per ogni oggetto (es: il conto Attività:Beni immobili:Auto:Costo per l’auto). In questo esempio si parte con €30.000 in banca, l’auto costa €20.000 e la macchina fotografica costa €10.000 entrambe acquistate il 1° Gennaio 2000.
[image: Esempio di svalutazione di un bene]La finestra principale dell’esempio di svalutazione del bene, prima del deprezzamento



Controllando i codici sulle tasse, si apprende che il deprezzamento deve essere calcolato utilizzando lo schema «somma delle cifre», su un periodo di 5 anni. Quindi, i deprezzamenti annuali per l’auto ammontano a €6.667, €5.333, €4.000, €2.667, €1.333 per gli anni da 1 a 5 rispettivamente, arrotondati all’euro. Gli importi della svalutazione annua per la macchina fotografica sono €3.333, €2.667, €2.000, €1.333, €667. Si consulti la sezione precedente sugli schemi di svalutazione per ritrovare la formula con cui questi valori sono stati calcolati.
Per ogni periodo contabile (anno fiscale) si deve registrare il deprezzamento come un’uscita nel corrispondente conto del deprezzamento accumulato (es: il conto Attività:Beni immobili:Auto:Deprezzamento per l’auto). Le due finestre più sotto mostrano il conto del deprezzamento accumulato relativo alla propria auto e la finestra principale dopo il terzo anno (es: il terzo periodo) di svalutazione utilizzando lo schema somma delle cifre.
[image: Finestra del registro di deprezzamento di un bene]La finestra del registro di deprezzamento di un bene



[image: Finestra principale di deprezzamento di un bene]La finestra principale di deprezzamento di un bene



Nota
ATTENZIONE: dato che il deprezzamento e il calcolo delle imposte sono fortemente legati, non si sarà sempre liberi di scegliere il metodo che si preferisce. La correzione di calcoli errati richiede sempre molto tempo e sforzo, più di quanto sia richiesto calcolando da subito i valori esatti; quindi, se si ha intenzione di svalutare dei beni, è bene informarsi prima di tutto su quale schema è permesso o necessario utilizzare.


Capitolo 18. Importare i dati dell’impresa



Importare fatture e ricevute



This functionality is only available by default for versions greater than 2.6
For 2.4.13 the Customers and Vendors importer is an optional module and needs to enabled by editing the file $HOME/.gnucash/config.user,
    adding the line:
(gnc:module-load "gnucash/plugins/bi_import" 0)
Su sistemi Linux questo file è $HOME/.gnucash/config.user e su MacOSX ~/Library/Application Support/GnuCash/config.user. Se il file non esiste già, lo si dovrà creare. Dopo aver riavviato GnuCash l’elemento comparirà alla fine del menu Impresa.
Perchè l’importatore funzioni correttamente, i dati devono essere in formato a lunghezza fissa di campo, o separati da virgole. Uno script di Python è fornito di seguito come esempio.

      

import sys
import csv

VENDOR_ID="000013"
INFILE=sys.argv[1]
INV_ID=sys.argv[2]
try:
  ACCOUNT=sys.argv[3]
except:
  ACCOUNT="Expenses:Materials General"

Reader = csv.reader(open(INFILE), delimiter=',')

# Need to ignore 1st and last rows

for row in Reader:
  if row[0].isdigit(): # We only use numbered lines
    outline=(INV_ID + ",," + VENDOR_ID + ",,,," + row[1] + " > " + row[4] + ",ea," +
      ACCOUNT + "," + row[2] + "," + row[5].replace("GBP", "") + ",,,,no,,,,,,,")
  print outline
      

    
Esempio di un file d’ordine del fornitore scaricato da Rapid Electronics (UK). 

line number,product code,quantity,availability,product description,unit price,discounts,line total,delivery,sub total,vat,grand total
1,47-3524,100,100 Available,BC848C SOT-23 NPN TRANSISTOR (INF) (RC),GBP0.03,GBP0.00,GBP0.03
2,47-3278,30,30 Available,L78L05ACZ 0.1A +5V VOLTAGE REG (ST) (RC),GBP0.18,GBP0.00,GBP0.18
3,22-0120,1,1 Available,Tube 34 14pin DIL socket, narrow7.62mm, without central support,GBP1.05,GBP0.00,GBP1.05
4,22-0127,1,0 Available<br />1 on Back Order,Tube 17 28pin DIL socket, wide15.24mm, without central support,GBP1.22,GBP0.00,GBP1.22
5,62-0368,1,1 Available,820R CR25 0.25W CF Resistor Pk 100,GBP0.50,GBP0.00,GBP0.50
6,47-3130,100,100 Available,1N4001 1A 50V SILICON RECTIFIER DIODE RC,GBP0.01,GBP0.00,GBP0.01
7,17-0310,1,1 Available,PROFESSIONAL MINATURE PROBE HOOK RED RC,GBP0.90,GBP0.00,GBP0.90
8,17-0312,1,1 Available,PROFESSIONAL MINATURE PROBE HOOK BLACKRC,GBP0.90,GBP0.00,GBP0.90
9,34-0655,1,1 Available,PROTOBLOC 2 BREADBOARD,GBP4.39,GBP0.00,GBP4.39
10,18-0200,1,1 Available,PP3 9V ALKALINE BATTERY "Not For Retail Sale",GBP1.37,GBP0.00,GBP1.37
,,,,,,,,GBP4.95,GBP24.93,GBP4.35,GBP29.28
      
Un file simile dopo essere stato processato con lo script di Python.

        

MEC-0071,,000013,,,,34-0655 > PROTOBLOC 2 BREADBOARD,ea,Expenses:Materials General,1,4.39,,,,no,,,,,,,
MEC-0071,,000013,,,,18-0105 > PP3 / PP6 BATTERY CLIP 150MM (RC),ea,Expenses:Materials General,10,0.06,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0370 > 1k CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0354 > 220R CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,34-5548 > PLAIN DOCUMENT WALLET ASSORTED PK 50 RE,ea,Expenses:Materials General,1,6.95,,,,no,,,,,,,
MEC-0071,,000013,,,,62-0386 > 4k7 CR25 0.25W CF Resistor Pk 100,ea,Expenses:Materials General,1,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,34-0860 > COPPER CLAD SRBP SS 100 X 160 (RC),ea,Expenses:Materials General,5,0.50,,,,no,,,,,,,
MEC-0071,,000013,,,,18-0163 > PP3 BATTERY HOLDER WITH FLYING LEADS RC,ea,Expenses:Materials General,5,0.23,,,,no,,,,,,,
MEC-0071,,000013,,,,73-4290 > ATMEGA8-16PU 8-BIT MICRO 8K DIL-28 (RC),ea,Expenses:Materials General,3,1.99,,,,no,,,,,,,
MEC-0071,,000013,,,,81-0014 > BC108 NPN GP TRANSISTOR RC,ea,Expenses:Materials General,20,0.16,,,,no,,,,,,,
MEC-0071,,000013,,,,DELIVERY,ea,Expenses:Postage,1,4.95,,,,no,,,,,,,
MEC-0071,,000013,,,,VAT,tax,Expenses:VAT,1,4.35,,,,no,,,,,,,
        

    
Come si può vedere mancano alcuni campi mentre altri non sono necessari per l’importazione. La prima riga e l’ultima sono superflue dato che GnuCash si prenderà cura di calcolare il totale. Tutto ciò che serve è di prelevare ciò che è necessario e produrre un file di output con il formato corretto per essere importato in GnuCash. In questo caso i campi del numero dell’elemento (part number) e della descrizione (description) verranno uniti per comporre la descrizione della fattura (o ricevuta) in GnuCash. Sono necessari il campo della quantità (quantity) e del prezzo (price). Contrariamente alla dicitura dell’intestazione, la VAT non è riportata per ogni riga dato che è sempre 0, ma è calcolata nell’ultima riga sul totale dell’ordine. 
Nota
Questo causerà problemi in seguito.

 In questo esempio il conto Uscite:Materiali generici è stato impostato come conto di destinazione. Questo può essere cambiato dopo l’importazione nel modo usuale, così come qualsiasi altro dato. Se questo conto non esiste, verrà lasciato vuoto durante l’importazione e dovrà essere impostato manualmente. Le righe che iniziano con il simbolo «#» sono considerate come commenti e quindi tralasciate.
Lo script è invocato con il seguente comando:
 python importer.py file_da_importare, invoice_id > file_in_cui_salvare.csv
      
Questo breve script può facilmente essere modificato per adattarlo a qualsiasi formato scaricato. L’unica restrizione riguarda il numero di campi che deve essere fisso, almeno al momento. L’importatore ignorerà le righe con un numero errato di campi (questo potrebbe essere corretto nelle versioni future). L’ID venditore è semplicemente il numero identificativo assegnato a quello specifico venditore. Gli elementi row[N] si riferiscono alla posizione dove sono presenti i dati. È importante notare come il primo campo sia row[0] e non row[1].
Una volta che il file è stato convertito, selezionare Impresa → Importa fatture e ricevute per aprire una nuova finestra di importazione. Selezionare il file appena creato, selezionare poi fattura o ricevuta e il formato separato da virgole. Controllare che i dati dei campi siano nelle colonne corrette prima di selezionare OK. Una volta importata la fattura può essere aperta per modificarla o per emetterla nel modo usuale.
Una nota sulla VAT o qualsiasi altra imposta sugli acquisti. Come già detto, Rapid Electronics calcola la VAT sul totale della ricevuta e non per ogni riga. GnuCash calcola la VAT per ogni riga e ne fai poi il totale. Questa differenza può comportare delle inaccuratezze nell’importo della VAT di alcuni centesimi che sono sufficienti a causare problemi in fase di riconciliazione del conto usato per l’acquisto. Al momento il superamento del problema dipende solamente dal proprio modo preferito; ad esempio la VAT può essere aggiunta manualmente in una riga separata come i costi di spedizione. QUindi parte del lavoro è lasciata all’utente ma la parte più noiosa di inserimento di ogni elemento è eliminata.
Per il fututro: attualmente il formato di importazione è ristertto e diversi utenti potrebbero andare incontro a dei problemi durante il processo di conversione. Aggiungere un modello per ogni possibile formato CSV dei fornitori sarebbe un lavoro enorme e probabilmente infruttuoso dato che molti fornitori spesso cambiano formato senza avvertire gli sviluppatori di GnuCash. I miglioramenti futuri del processo di importazione saranno basati sui consigli degli utenti e probabilemente verrà reso più semplice o flessibile (spesso «semplice» non è compatibile con «flessibile»).
Nota
Se non si ha dimestichezza con Python (esistono altri linguaggi), è possibile inviare una richiesta alla lista dell’utente di GnuCash, con un esempio del proprio file CSV scaricato, e probabilmente qualcuno si preoccuperà di scrivere uno script di Python per la sua traduzione.

Note per gli autori Python



Per poter completare con successo il processo di importazione, il numero di campi deve essere rispettato, quindi le virgole sono importanti.
Di seguito è riportato un elenco completo dei campi necessari:
id, date_opened, owner_id, billingid, notes, date, desc, action, account, quantity, price, disc_type, disc_how, discount, taxable, taxincluded, tax_table, date_posted, due_date, account_posted, memo_posted, accu_splits,
Nota
Si noti la virgola finale


Una breve descrizione di ogni campo



	id - il numero della fattura. Tutte le righe devono contenerlo o la riga verrà rifiutata.

	date_opened -
             Use the same date format as setup in Preferences. Today's date is inserted if this is blank.
          

	owner_id - numero ID del venditore o del cliente. Tutte le righe devono contenere questo valore altrimenti verranno rifiutate.

	billingid — ID ricevuta.

	notes — note della fattura.

	date - la dta dell’elemento sulla riga. Può essere lasciata vuota per considerarla in data odierna.

	desc - descrizione della fattura o della ricevuta

	action - per le ricevute normalmente è «ea».

	account - il conto a cui è attribuito l’elemento.

	quantity - quantità di ogni elemento. Deve contenere un valore o la riga verrà rifiutata.

	price - prezzo di ogni elemento. Deve contenere un valore o la riga verrà rifiutata.

	disc_type - tipo di sconto; può essere «%» o «TODO». Si applica solo alle fatture. È necessario fare qualche prova in questo caso dato che può essere funzione della valuta.

	disc_how - si applica solamente alle fatture.

	discount - importo dello sconto applicato. Si applica solamente alle fatture.

	taxable -
            Will tax be applied to the item? «yes» or blank.
          

	taxincluded -
            Is tax included in the item price? «yes» or blank.
          

	tax_table — tabella delle imposte da applicare all’elemento.

	date_posted -
            If posted, what date. Normally left blank for manual
            posting after editing the invoice.  Use the same date format as setup in Preferences.
          

	due_date -
            Date payment is due.   Use the same date format as setup in Preferences.
          

	account_posted — conto di emissione.

	memo_posted  -
            If posted insert memo here.
          

	accu_splits -
            Accumulate splits? «yes» or blank.
          






Parte IV. Appendices




Appendice D. Formati di file ausiliari



Questi sono i formati di alcuni file ausiliari utilizzati da GnuCash.
File di formato per gli assegni (Check Format File *.chk)



In generale



Il file di formato per gli assegni è utilizzato per indicare a GnuCash come stampare uno o più assegni in un foglio di carta. Questo file descrive dapprima la disposizione generale della pagina (numero di assegni, orientazione, ecc...) e poi descrive l’impaginazione delle singole voci per ogni assegno. Il file è organizzato nel tipico formato a chiave e valore utilizzato dalla maggior parte delle applicazioni Linux. Le coppie di chiave e valore sono raggruppate in sezioni che iniziano con il nome del gruppo racchiuso tra parentesi quadre.
GnuCash cerca i file di formato per gli assegni in due differenti posizioni nel momento in cui viene aperta la finestra di stampa degli assegni: la prima posizione è generalmente /usr/share/gnucash/checks, dove risiedono i file di formato distribuiti con il programma; la seconda posizione è la cartella personale ~/.gnucash/checks. L’utente può aggiungere dei file di formato in qualsiasi momento (anche mentre GnuCash è in esecuzione) copiando semplicemente un nuovo file *.chk in questa cartella. Aprendo nuovamente la finestra di stampa degli assegni, il nuovo formato apparirà nella lista di quelli disponibili.
Nota
La stampa funziona in modo differente in funzione della versione di GTK installata nel sistema. Quando GnuCash utilizza una versione precedente alla 2.10, tutti gli spostamenti sono misurati a partire dall’angolo in basso a sinistra del foglio o dell’assegno singolo; quando invece si utilizza la versione 2.10 o successive, tutti gli spostamenti sono relativi all’angolo in alto a sinistra del foglio o del singolo assegno.


Esempio di contenuto del file



Un tipico file per gli assegni di GnuCash è mostrato di seguito. Il contenuto di questo file verrà descritto nelle sezioni successive.

[Top]
Guid = 67b144d1-96a5-48d5-9337-0e1083bbf229
Title = Quicken/QuickBooks (tm) US-Letter
Rotation = 0.0
Translation = 0.0;4.0
Show_Grid = false
Show_Boxes = false

[Check Positions]
Height = 252.0
Names = Top;Middle;Bottom

[Check Items]
Type_1 = PAYEE
Coords_1 = 90.0;102.0;400.0;20.0

Type_2 = AMOUNT_WORDS
Coords_2 = 90.0;132.0

Type_3 = AMOUNT_NUMBER
Blocking_Chars_3 = true
Coords_3 = 500.0;102.0

Type_4 = DATE
Coords_4 = 500.0;67.0

Type_5 = NOTES
Coords_5 = 50.0;212.0
        

Descrizione dei campi



Gruppo Top



Questa sezione del file degli assegni descrive la disposizione generale nella pagina degli assegni (o dell’assegno) che vengono immessi nella stampante.
Tabella D.1. Campo per la descrizione della disposizione generale
	Nome	Tipo	Necessario	Descrizione
	Guid	stringa	obbligatorio	Il codice guid permette di identificare univocamente un formato di assegni utilizzato da GnuCash. Deve essere unico tra tutti quelli delle applicazioni fornite e quelli forniti dall’utente. Se si copia un file di formato esistente da utilizzare come base per le proprie modifiche, questo valore deve essere cambiato. Il programma uuidgen può essere usato per generare questo identificativo.
	Titolo	stringa	obbligatorio	Il campo title permette di identificare univocamente il formato di assegni da parte dell’utente. Questo valore è presentato tale e quale nella lista dei formati presente nella finestra di stampa degli assegni. Se si copia un file di formato esistente da utilizzare come base per le proprie modifiche, questo valore deve essere cambiato adottando una qualsiasi stringa in formato utf-8.
	Carattere	stringa	opzionale	Se fornita, rappresenta il carattere predefinito utilizzato per stampare tutti campi di testo nell’assegno. Questo campo può contenere qualsiasi stringa accettata da GTK come carattere. Se questo campo è lasciato vuoto, verrà utilizzato il carattere predefinito indicato nelle preferenze di GnuCash. Un valore tipico può essere «sans 12».
	Blocking_Chars	Booleano	opzionale	Se fornito, rappresenta il valore di default quando si stampano tutti gli elementi TEXT su questo assegno. Quando impostato a «true», stampa i caratteri *** prima e dopo ogni campo di testo nell’assegno. I caratteri di blocco sono stampati per proteggere i campi di testo da modifiche. Per esempio, il campo dell’importo potrebbe essere stampato come ***100,00***
	DateFormat	Booleano	opzionale	Se fornito, rappresenta il valore predifinto quando si stampano tutti gli elementi DATE su questo assegno. Se impostato a «true», il formato di data verrà stampato in 8 punti, centrato e sopra la data corrente. Per esempio DDMMYYYY.
	Rotation	virgola mobile	opzionale	Questo valore indica la rotazione di tutta la pagina (in gradi) rispetto al punto di origine. Per le versioni di GTK precedenti alla 2.10, il punto di origine è situato nell’angolo in basso a sinistra della pagina e la rotazione è positiva in senso antiorario. Per le versioni di GTK superiori o uguali alla 2.10, il punto di origine è nell’angolo in alto a sinistra della pagina e la rotazione è positiva in senso orario. La rotazione della pagina è applicata prima della traslazione.
	Translation	elenco di 2 numeri a virgola mobile	opzionale	Questi valori specificano la rotazione lungo x e lungo y dell’intera pagina (in punti) relativamente al punto di origine. Per le versioni di GTK precedenti alla 2.10, il punto di origine è situato nell’angolo in basso a sinistra della pagina e la traslazione è positiva verso l’alto e verso destra. Per le versioni di GTK superiori o uguali alla 2.10, il punto di origine è nell’angolo in alto a sinistra della pagina e la traslazione è positiva verso destra e verso il basso. La rotazione alla pagina è applicata prima della traslazione.
	Show_Grid	Booleano	opzionale	Se questo valore è impostato a true allora GnuCash disegnerà una griglia nella pagina, partendo dal punto di origine con delle linee intervallate di 50 punti. Questa opzione è utile quando si desidera creare un nuovo file di formato per la stampa degli assegni.
	Show_Boxes	Booleano	opzionale	Se questo valore è impostato a true allora per ogni elemento di cui sono state specificate larghezza e altezza, GnuCash disegnerà un riquadro che mostra la posizione e l’ingombro massimo dell’elemento stesso. Questa opzione è utile quando si desidera creare un nuovo file di formato per la stampa degli assegni.




Nota
Le opzioni Blocking_Chars e DateFormat sono definite per tutti i formati di assegno nella scheda Stampa in Modifica → Preferenze. Si raccomanda che queste opzioni globali rimangano impostate a falso (valore predefinito) e che vengano invece impostate per ogni assegno nel gruppo Check Items come descritto nel seguito.


Gruppo Check Positions



Questo gruppo di elementi specifica come sono distribuiti gli assegni nel foglio di carta e fornisce dei nomi a ogni posizione di un assegno in modo che l’utente possa indicare a GnuCash quale di queste posizioni debba essere stampata. Questo gruppo di valori e chiavi è opzionale e deve essere tralasciato se si desidera che venga stampato un solo assegno per foglio.
Tabella D.2. Campi per la stampa di più assegni per foglio
	Nome	Tipo	Necessario	Descrizione
	Altezza	virgola mobile	obbligatorio	Questo campo specifica l’altezza del singolo assegno nella pagina. Se si desidera stampare più di un assegno per pagina, allora questo campo è obbligatorio. Se si desidera invece stampare un solo assegno per foglio, tutta la sezione dovrebbe essere tralasciata.
	Names	elenco di stringhe	obbligatorio	Questo campo specifica i nomi delle posizioni degli assegni che possono essere stampati per ogni pagina. Questi nomi rappresentano le posizioni dell’assegno partendo dall’alto della pagina e spostandosi verso il basso. I nomi vengono indicati in modo identico nella lista delle posizioni presente nella finestra di stampa degli assegni. Un valore tipico per questo campo può essere Top;Middle;Bottom, ma potrebbe anche essere First;Second;Third o qualsiasi altro insieme di stringhe che identifica chiaramente la posizione dell’assegno. Se si desidera stampare più di un assegno per pagina, allora questo campo è obbligatorio. Se si desidera invece stampare un solo assegno per foglio, tutta la sezione dovrebbe essere tralasciata..





Gruppo Check Items



Questa sezione indica le singole voci da stampare sull’assegno. Non c’è limite al numero di voci che è possibile inserire e la stessa tipologia può essere ripetuta più volte; questo permette la stampa di assegni che hanno una matrice laterale, o degli assegni per le imprese che sono uno per pagina e che hanno sia l’assegno e le matrici multiple nella stessa pagina. per esempio, per stampare il nome del beneficiario in un assegno per imprese e in entrambe le matrici, basta specificare tre diverse voci del tipo Payee con differenti coordinate per la stampa.
Ogni nome di chiave contenuta in questa sezione include esplicitamente il numero dell’elemento a cui viene applicata: es. la chiave denominata Type_1 si applica al primo elemento stampato e la chiave Coords_3 viene applicata al terzo elemento che deve essere stampato. I numeri delle voci cominciano da uno e crescono in modo sequenziale. Ogni salto nella numerazione viene interpretato da GnuCash come la fine della lista della voce. Gli elementi sono stampati secondo l’ordine numerico, non nell’ordine con cui appaiono nel file.
Ogni elemento specificato deve includere un tipo di dichiarazione. I restanti parametri per l’elemento dipendo dal suo particolare tipo. Consultare la Tabella D.4, «Tipi di voci per un singolo assegno» per recuperare una lista di tipi di elementi validi e i rispettivi parametri richiesti.
Tabella D.3. Campi degli elementi per un unico assegno
	Nome	Tipo	Necessario	Descrizione
	Type_n	stringa	obbligatorio	Questo campo specifica il tipo di elemento da stampare sull’assegno. Consultare la Tabella D.4, «Tipi di voci per un singolo assegno» per una lista di voci valide.
	Coords_n	elenco di 2 o 4 numeri a virgola mobile	obbligatorio	Questo campo specifica le coordinate in cui la voce verrà inserita nell’assegno e, opzionalmente, ne specifica anche l’altezza e la larghezza. I valori rappresentano rispettivamente gli spostamenti lungo agli assi X e Y rispetto all’angolo in basso a sinistra dell’elemento e opzionalmente la sua larghezza e altezza. Se viene fornito un valore per l’altezza, allora deve essere inserita anche la larghezza e quindi questo campo deve contenere 2 o 4 valori. Per le versioni GTK precedenti alla 2.10, il punto di origine è nell’angolo in bsso a sinistra della pagina e le traslazioni sono positive verso l’alto e verso destra. Per le versioni GTK 2.10 e superiori, il punto di origine è situato in alto a sinistra e le traslazioni sono positive verso il basso e verso destra. Nota
Indipendentemente dalla posizione del punto di origine (in alto o in basso), le coordinate specificano sempre il punto in basso a sinistra dell’elemento.


	Font_n	stringa	opzionale	Se fornita, rappresenta il carattere utilizzato per stampare la specifica voce di testo. Questo campo può contenere una stringa qualsiasi purché sia accettata da GTK. Se questo campo è lasciato vuoto, verrà utilizzato il carattere predefinito specificato nella sezione Iniziale del file di descrizione degli assegni o, se anche questo è stato tralasciato, il carattere specificato nelle preferenze di GnuCash. Questo campo viene riconosciuto solamente se si utilizza GTK 2.10 o successivo.
	Align_n	stringa	opzionale	Se fornita, rappresenta l’allineamento utilizzato per stampare la specifica voce di testo. Questo campo deve contenere una delle seguenti stringhe «sinistra», «centro» o «destra». Se questo campo è lasciato vuoto, il testo verrà allineato a sinistra. Questo campo viene riconosciuto solamente se si utilizzano le GTK 2.10 o successive.
	Text_n	stringa	opzionale	Questo campo è utilizzato solamente quando il tipo di voce è impostato a TEXT. Specifica il testo, in formato utf-8, da stampare sull’assegno.
	Filename_n	stringa	opzionale	Questo campo è utilizzato solamente quando il tipo di elemento è impostato a PICTURE. Specifica il nome del file dell’immagine da stampare sull’assegno. La stringa può specificare un percorso assoluto o relativo. In quest’ultimo caso, GnuCash controlla prima nella cartella dei formati di assegno forniti dal programma (generalmente /usr/share/gnucash/checks) e, se non lo dovesse trovare, cercherà nella cartella personale ~/.gnucash/checks. Questo campo viene riconosciuto solamente se si utilizza GTK 2.10 o successivo.
	Blocking_Chars_n	Booleano	opzionale	Se fornito, imposta l’opzione di stampa Blocking_Chars per questo elemento.
	DateFormat_n	Booleano	opzionale	Se fornito, imposta l’opzione di stampa DateFormat per questo elemento.




Queste sono le voci che possono essere stampate individualmente su un assegno; necessitano tutte delle coordinate rispetto alla pagina dove devono essere stampate. La maggioranza di queste voci producono la stampa di un testo sul foglio ed è possibile, per ognuna di esse, specificare un carattere e un allineamento. Per esempio, l’importo in cifre di un assegno può essere stampato con la giustificazione a destra mentre, tutto il resto, giustificato a sinistra. Gli altri tipi devono avere dei parametri unici.
Tabella D.4. Tipi di voci per un singolo assegno
	Nome	Valori obbligatorio	Valori facoltativi	Descrizione
	PAYEE	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare il nome del beneficiario partendo dalle coordinate specificate.
	DATE	Coordinate	
                    Font

Align

Blocking_Chars

DateFormat

                    


                  	Questo valore del tipo indica a GnuCash di stampare la data partendo dalle coordinate specificate.
	NOTES	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare il campo delle note della transazione partendo dalle coordinate specificate.
	CHECK_NUMBER	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash
                    to print the check number at the specified coordinates. The
                    check number reflects the book option selection under
                    File → Proprietà for number source (transaction
                    number or anchor-split action - see Use Split
                    Action Field for Number in the Book Options section
                    of the GnuCash Help Manual).
                  
	MEMO	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare il il campo promemoria della suddivisione partendo dalle coordinate specificate.
	ACTION	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	This type value tells GnuCash
                    to print the split action field at the specified coordinates.
                    However, the printed field reflects the book option selection
                    under File → Proprietà for number source
                    (transaction number or anchor-split action - see 
                    Use Split Action Field for Number in the Book
                    Options section of the GnuCash Help
                    Manual). If number source for the book is specified as
                    anchor-split action, this field will instead print the
                    transaction number field.
                  
	AMOUNT_WORDS	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare l’importo in lettere dell’assegno partendo dalle coordinate specificate. L’importo apparirà nella forma Un milione, due cento trenta quattro e 56/100.
	AMOUNT_NUMBER	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare l’importo in cifre dell’assegno partendo dalle coordinate specificate. L’importo apparirà nella forma €1.234,56.
	ADDRESS	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare l’indirizzo alle coordinate specificate.
	SPLITS_ACCOUNT	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare i nomi dei conti per ogni suddivisione partendo dalle coordinate specificate. Vedere la nota sulla stampa delle suddivisioni.
	SPLITS_AMOUNT	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare l’importo per ogni suddivisione partendo dalle coordinate specificate. Gli importi sono stampati con il simbolo della valuta. Vedere la nota sulla stampa delle suddivisioni.
	SPLITS_MEMO	Coordinate	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare il campo del promemoria partendo dalle coordinate specificate. Vedere la nota sulla stampa delle suddivisioni.
	TEXT	Coordinate, testo	
                    Font

Align

Blocking_Chars

                    


                  	Questo valore del tipo indica a GnuCash di stampare una stringa arbitraria partendo dalle coordinate specificate. La stringa da stampare è specificata dalla chiave Text_n.
	PICTURE	Coordinate, nome del file	(nessuno)	Questo valore del tipo indica a GnuCash di stampare un’immagine partendo dalle coordinate specificate. L’immagine da stampare è specificata attraverso la chiave Filename_n. Questo tipo è riconosciuto solamente quando si utilizza GTK 2.10 o successiva.




Nota
SPLIT items include all split entries for the transaction
            except for the split that applies to the current account register
            (referred to as the anchor-split).  This is usually the last split
            listed when splits are displayed in the register.  The coordinate
            location defines the lower left location for the split information.
           



Creare dei file di formato per gli assegni



Creare un proprio file di formato per gli assegni è un’operazione piuttosto semplice. Il metodo più semplice consiste nel copiare un file di formato esistente dalla cartella del programma (generalmente /usr/share/gnucash/checks) alla cartella ~/.gnucash/checks. È importante ricordarsi di cambiare il valore guid per fare in modo che il nuovo file venga accettato da GnuCash e di cambiare il titolo in modo che sia di descrittivo. A questo punto è possibile cambiare e aggiungere i campi come si desidera. È possibile anche creare un nuovo file di formato premendo il pulsante Salva formato nella pagina del Formato personalizzato della finestra di stampa degli assegni.
Nota
I nomi delle chiavi sono sensibili alle lettere maiuscole o minuscole. Se si avessero dei problemi con un file di formato per gli assegni, assicurarsi che tutti i nomi delle chiavi inizino con la lettera maiuscola.




Appendice E. Documentazione sulla licenza libera GNU (in inglese)

Versione 1.1, Marzo 2000

Diritto d'autore © 2000 Free Software Foundation, Inc.

Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA02111-1307USA

 Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.




0. PREAMBLE



The purpose of this License is to make a manual, textbook, or other written document «free» in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.
This License is a kind of «copyleft», which means that derivative works of the document must themselves be free in the same sense. It complements the GNU General Public License, which is a copyleft license designed for free software.
We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose is instruction or reference.


1. APPLICABILITY AND DEFINITIONS



This License applies to any manual or other work that contains a notice placed by the copyright holder saying it can be distributed under the terms of this License. The «Document», below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as «you».
A «Modified Version» of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications and/or translated into another language.
A «Secondary Section» is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject. (For example, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.
The «Invariant Sections» are certain  Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the Document is released under this License.
The «Cover Texts» are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document is released under this License.
A «Transparent» copy of the  Document means a machine-readable copy, represented in a format whose specification is available to the general public, whose contents can be viewed and edited directly and straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup has been designed to thwart or discourage subsequent modification by readers is not Transparent. A copy that is not «Transparent» is called «Opaque».
Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-conforming simple HTML designed for human modification. Opaque formats include PostScript, PDF, proprietary formats that can be read and edited only by proprietary word processors, SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML produced by some word processors for output purposes only.
The «Title Page» means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires to appear in the title page. For works in formats which do not have any title page as such, «Title Page» means the text near the most prominent appearance of the work’s title, preceding the beginning of the body of the text.

2. VERBATIM COPYING



You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices, and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute. However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions in section 3.
You may also lend copies, under the same conditions stated above, and you may publicly display copies.

4. MODIFICATIONS



You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:
	A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version gives permission.

	B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together with at least five of the principal authors of the Document (all of its principal authors, if it has less than five).

	C. State on the Title Page the name of the publisher of the Modified Version, as the publisher.

	D. Preserve all the copyright notices of the Document.

	E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

	F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this License, in the form shown in the Addendum below.

	G. Preserve in that license notice the full lists of  Invariant Sections and required Cover Texts given in the Document’s license notice.

	H. Include an unaltered copy of this License.

	I. Preserve the section entitled «History», and its title, and add to it an item stating at least the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is no section entitled «History» in the Document, create one stating the title, year, authors, and publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

	J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network locations given in the Document for previous versions it was based on. These may be placed in the «History» section. You may omit a network location for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

	K. In any section entitled «Acknowledgements» or «Dedications», preserve the section’s title, and preserve in the section all the substance and tone of each of the contributor acknowledgements and/or dedications given therein.

	L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered part of the section titles.

	M. Delete any section entitled «Endorsements». Such a section may not be included in the Modified Version.

	N. Do not retitle any existing section as «Endorsements» or to conflict in title with any Invariant Section.



If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the Modified Version’s license notice. These titles must be distinct from any other section titles.
You may add a section entitled «Endorsements», provided it contains nothing but endorsements of your Modified Version by various parties--for example, statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.
You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher that added the old one.
The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement of any Modified Version .
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